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WARRANTY STATEMENT 
This warranty applies to the Gasmet brand name products sold with this warranty 
statement. This warranty is applicable in all countries and may be enforced in any 
country where Gasmet Technologies Oy or its subsidiaries or its authorised service 
providers offer warranty service subject to the terms and conditions set forth in this 
warranty statement. 
 
Gasmet Technologies Oy and its subsidiaries guarantee that all products manufactured 
and sold by it are free of defects in materials and workmanship under normal use 
during the warranty period. 
 
The products of Gasmet Technologies Oy and its subsidiaries are manufactured using 
new materials or new and used materials equivalent to new in performance and 
reliability. Spare parts may be new or equivalent to new. 
 
Gasmet Technologies Oy and its subsidiaries agree to either replace or repair free of 
charge (Ex Works Helsinki, Incoterms 2000) any such defective product or part that is 
returned to its repair facility within one (1) year of the delivery date. All parts or products 
removed under this warranty become the property of Gasmet Technologies Oy or its 
subsidiaries. The replacement product or part takes on the warranty status of the 
removed product or part. 
 
The warranty does not extend to any product from which the serial number has been 
removed or that has been damaged or rendered defective (a) as a result of accident, 
misuse, abuse, normal wear of components or other external causes; (b) by operation 
outside the usage parameters stated in the user documentation that is provided with the 
product; (c) by the use of parts not manufactured by Gasmet Technologies Oy and its 
subsidiaries; or (d) by modification or service by anyone other than Gasmet 
Technologies Oy and its subsidiaries. 
 
Gasmet Technologies Oy and its subsidiaries are not liable for any damages caused by 
the product or the failure of the product to perform, including any loss of profits or 
savings, incidental damages, or consequential damages. 
 
Gasmet Technologies Oy shall not be liable for technical or editorial errors or omissions 
contained herein. The information in this document is provided “as is” without guarantee 
of any kind and is subject to change without notice. Should you find any errors, we 
would appreciate if you notified us.  
 
Gasmet™, Calcmet™, Calcmet Lite™, and GICCOR™ are trademarks of Gasmet 
Technologies Oy. Windows® is a registered trademark of Microsoft Corporation. Teflon® 
is a registered trademark of E.I. du Pont de Nemours & Co., Inc. Viton® and Kalrez® are 
registered trademarks of DuPont Dow Elastomers. Bluetooth® is a registered trademark 
of Bluetooth SIG, Inc. 
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 WARNING. READ BEFORE USING ANALYSER 
To avoid possible electrical shock or personal injury, follow these guidelines:  
 
- Use the analyser only as specified in this manual or the analyser could be irreversibly 
damaged. 
 
- Do not use the analyser or probe or external AC/DC power supply unit1 or battery if 
they appear damaged, or if they operate incorrectly. If in doubt, have the analyser 
serviced by trained service personnel. 
 
- Always use the proper original Gasmet parts, and respect Gasmet suggested 
measurement conditions. 
 
- Do not apply an input AC voltage to the external AC/DC power supply unit different 
than what indicated on the external AC/DC power supply unit name plate. 
 
- Always use a proper earth ground under external AC/DC power supply unit use. 
 
- Do not use the analyser in EX rated areas. 
 
- The equipment2 must not be operated in wet conditions. 
 
- Do not drop the analyser. 
 
- The DX4040 Instruction and Operating Manual should be read and understood before 
operating your unit. 
 

Symbols 
 AC (Alternating Current)  DC (Direct Current) 

 Important Information; refer to manual  WEEE symbol (Waste Electrical and 
Electronic Equipment Directive) 

 Conforms to European Union directives  Canadian Standards Association 

 
1: AC/DC PSU will later refer to external AC/DC power supply unit. 
2: Equipment refer to the external AC/DC power supply unit, the battery and the 
analyser. 
 

 
3 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 

CONTENTS 

WARRANTY STATEMENT ........................................................................................................ 2 

 WARNING. READ BEFORE USING ANALYSER ................................................................ 3 

CONTENTS ................................................................................................................................... 4 

FIGURES ....................................................................................................................................... 7 

TABLES ......................................................................................................................................... 8 

PREFACE ...................................................................................................................................... 9 

1 INTRODUCTION .................................................................................................................. 10 

2 SUPPLIED GOODS ............................................................................................................... 11 

2.1 PACKAGE ........................................................................................................................... 11 
2.2 LIST OF ITEMS DELIVERED FOR DX4040 ......................................................................... 11 
2.3 GASMET CONFIGURATION ................................................................................................. 12 

3 PRINCIPLE OF MEASUREMENT ..................................................................................... 13 

3.1 PRINCIPLES OF INFRARED SPECTROSCOPY ..................................................................... 13 
3.2 COMPONENTS OF A FOURIER TRANSFORM INFRARED SPECTROMETER ......................... 15 
3.3 QUANTITATIVE ANALYSIS OF FTIR SPECTRA .................................................................. 17 
3.4 MULTI-COMPONENT ANALYSIS.......................................................................................... 18 
3.5 THE SPECTRAL RESOLUTION OF FTIR ANALYSIS ........................................................... 19 

4 GASMET DX4040 FTIR GAS ANALYSER ....................................................................... 21 

4.1 INTRODUCTION ................................................................................................................... 21 
4.1.1 Applications of the Gasmet DX4040 Analyser ................................................. 21 
4.1.2 Structure of the Gasmet DX4040 Analyser ....................................................... 21 

4.2 GASMET DX4040 TECHNICAL SPECIFICATIONS .............................................................. 22 
4.2.1 General Parameters ............................................................................................. 22 
4.2.2 Spectrometer ......................................................................................................... 23 
4.2.3 Sample Cell ............................................................................................................ 23 
4.2.4 Measuring Parameters ......................................................................................... 24 
4.2.5 Electrical Connectors ............................................................................................ 24 
4.2.6 Gas Inlet and Outlet Conditions .......................................................................... 24 
4.2.7 Electronics .............................................................................................................. 25 
4.2.8 Analysis Software .................................................................................................. 25 
4.2.9 Additional Information ........................................................................................... 25 

4.3 GASMET DX4040 TECHNICAL DESCRIPTION ................................................................... 26 
4.3.1 Analyser Enclosure ............................................................................................... 26 
4.3.2 Power Supply ......................................................................................................... 27 
4.3.3 Front Panel ............................................................................................................. 29 
4.3.4 On-board Sample Pump ...................................................................................... 35 
4.3.5 On-board Fans ....................................................................................................... 35 
4.3.6 Probe ....................................................................................................................... 36 
4.3.7 Carrying Handle, Shoulder strap and Carrying Harness ................................ 36 

 
4 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 
4.3.8 Personal Digital Assistant (PDA) ........................................................................ 36 
4.3.9 Optional Computer ................................................................................................ 36 

5 EQUIPMENT INSTALLATION .......................................................................................... 38 

5.1 STORAGE AND PACKAGING CONDITIONS ......................................................................... 38 
5.2 OPERATING CONDITIONS .................................................................................................. 38 

5.2.1 Lifting and Carrying Instructions ......................................................................... 38 
5.2.2 Installation Location .............................................................................................. 39 
5.2.3 Ventilation Requirements ..................................................................................... 39 
5.2.4 Operating Requirements ...................................................................................... 39 
5.2.5 Protective Earthing Instructions .......................................................................... 40 
5.2.6 Supply Connection ................................................................................................ 40 
5.2.7 Sound Level ........................................................................................................... 41 
5.2.8 Explosion Protection ............................................................................................. 41 

6 EQUIPMENT OPERATION ................................................................................................ 42 

6.1 QUICK PDA GUIDE ........................................................................................................... 42 
6.2 SOFTWARE SETUP ............................................................................................................ 42 

6.2.1 Software Pre-requirements .................................................................................. 43 
6.2.2 Synchronization PDA/Computer ......................................................................... 43 
6.2.3 HASP Key Driver Installation ............................................................................... 44 
6.2.4 USB to Serial Converter Installation................................................................... 44 
6.2.5 Calcmet Software Installation .............................................................................. 46 
6.2.6 Calcmet Library Installation ................................................................................. 47 
6.2.7 Calcmet Software Configuration ......................................................................... 47 

6.2 ZERO CALIBRATION AND HARDWARE STATUS CHECK .................................................... 47 
6.3 CALCMET APPLICATION CREATION .................................................................................. 48 
6.4 CALCMET LITE USER’S GUIDE AND REFERENCE MANUAL .............................................. 49 

6.4.1 Calcmet Lite Application Installation .................................................................. 49 
6.4.2 PDA Configuration ................................................................................................ 49 
6.4.3 CALCMETLITE.INI File ........................................................................................ 49 
6.4.4 Calcmet Lite Install/Uninstall ............................................................................... 51 
6.4.5 Operating DX4040 via Bluetooth ........................................................................ 51 
6.4.6 Hardware Status .................................................................................................... 52 
6.4.7 Zero Calibration ..................................................................................................... 53 
6.4.8 Measurements ....................................................................................................... 55 
6.4.9 Emailing Results and Spectra ............................................................................. 58 
6.4.10 Checking Storage Space ..................................................................................... 59 
6.4.11 Flushing and Switching Off DX4040 via Bluetooth .......................................... 59 
6.4.12 Transferring of Spectrum/Results Files ............................................................. 60 
6.4.13 Application Selection ............................................................................................ 60 
6.4.14 Update Calcmet Lite Settings .............................................................................. 61 

6.5 MEASUREMENTS SUMMARY .............................................................................................. 62 

7 EQUIPMENT MAINTENANCE AND SERVICE ............................................................. 63 

7.1 SAFETY PRECAUTIONS ...................................................................................................... 63 
7.2 PARTS INFORMATION ........................................................................................................ 63 
7.3 MAINTENANCE PLAN ......................................................................................................... 64 
7.4 ENCLOSURE CLEANING ..................................................................................................... 64 
7.5 REPLACING/CLEANING DUST FILTERS ............................................................................. 65 
7.6 REPLACING PROBE FILTER ............................................................................................... 65 

 
5 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 
7.7 VISUAL INSPECTION........................................................................................................... 66 
7.8 SAMPLE CELL INSPECTION ............................................................................................... 66 
7.9 REPLACEMENT OF OPTOELECTRONIC COMPONENTS ...................................................... 66 

8 ANALYSER INSPECTION .................................................................................................. 67 

APPENDIX A: BLUETOOTH SETUP .......................................................................................... 68 

APPENDIX B: INSTALL/UNINSTALL CALCMET LITE ..................................................... 69 

APPENDIX C: LI-ION BATTERIES GENERAL USAGE INSTRUCTIONS ..................... 70 

APPENDIX D: RECOMMENDATIONS TO THE END-USERS OF BATTERIES ............ 71 

APPENDIX E: LASER SAFETY INFORMATION ................................................................. 72 

APPENDIX F: CERTIFICATION .............................................................................................. 73 

APPENDIX G: VOCABULARY ................................................................................................ 74 

APPENDIX H: GASMET SALES AND SUPPORT OFFICES ............................................ 75 

 

 
6 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 

FIGURES 
Figure 1. The four normal modes of vibration of carbon dioxide CO2 molecule. ............ 14 
Figure 2. An absorbance spectrum of carbon dioxide CO2 measured with a DX-4015 

model. c(CO2) = 50 ppm, T = 50 oC, absorption path length = 9.8 m. ........................ 15 
Figure 3. The basic components of an FTIR spectrometer are infrared source, 

interferometer, sample cell, detector, and signal and data processing unit. .............. 15 
Figure 4. A Michelson interferometer is a unique part of an FTIR spectrometer. ........... 16 
Figure 5. A typical interferogram. ............................................................................................ 17 
Figure 6. An example of spectra for multi-component analysis. The spectral analysis 

routine in Calcmet Lite software performs all calculations automatically. .................. 19 
Figure 7. Basic structure of the Gasmet DX4040 analyser. ............................................... 22 
Figure 8. Dimensional drawing of the DX4040 analyser enclosure. ................................. 26 
Figure 9. Battery LED indicator. .............................................................................................. 28 
Figure 10. Front panel: sample gas fittings and connectors of the DX4040 model. ...... 29 
Figure 11. Gas fittings. .............................................................................................................. 30 
Figure 12. User Account Control settings. ............................................................................. 43 
Figure 13. Calcmet Welcome window.................................................................................... 47 
Figure 14. Calcmet calibration information............................................................................ 48 
Figure 15. Correct Calcmet Lite start-up sequence. ............................................................ 52 
Figure 16. Calcmet Lite Hardware Status. ............................................................................ 52 
Figure 17. Calcmet Lite zero calibration. ............................................................................... 54 
Figure 18. Activate pump during continuous measurement. .............................................. 54 
Figure 19. Save spectrum files. ............................................................................................... 55 
Figure 20. START - STOP measurement. ............................................................................ 56 
Figure 21. Measurement results (spectrum or analysis). .................................................... 57 
Figure 22. Scrolling the results. ............................................................................................... 57 
Figure 23. E-mailing options. ................................................................................................... 59 
Figure 24. Storage information. ............................................................................................... 59 
Figure 25. Switch off the analyser. ......................................................................................... 60 
Figure 26. Application selection. ............................................................................................. 60 
Figure 27. Calcmet Lite settings. ............................................................................................ 61 
Figure 28. Dust filters cleaning. ............................................................................................... 65 
Figure 29. Probe filter cleaning. .............................................................................................. 66 
 

 
7 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 

TABLES 
Table 1. Power switch in Off mode. ........................................................................................ 32 
Table 2. Power switch in Cable mode. ................................................................................... 32 
Table 3. Power switch in Bluetooth mode. ............................................................................. 33 
Table 4. Battery relative state of charge status. ................................................................... 34 
Table 5. Battery charging – LED status. ................................................................................ 34 
Table 6. Battery relative state of charge status (0 % to 10 %). .......................................... 34 
Table 7. Battery disconnected. ................................................................................................ 34 
Table 8. Battery temperature or charger temperature not correct. .................................... 34 
Table 9. AC/DC PSU error. ...................................................................................................... 35 
Table 10. SMBus error. ............................................................................................................. 35 
Table 11. Charger communication error. ............................................................................... 35 
Table 12. Hardware status results. ......................................................................................... 48 
Table 13. Maintenance plan. .................................................................................................... 64 

 
8 



                     DX4040 INSTRUCTION AND OPERATING MANUAL (E2.05) 

 

PREFACE 
Thank you for choosing Gasmet, the state-of-the-art FTIR gas analyser manufactured 
by Gasmet Technologies Oy. Gasmet is a high-technology product made of high quality 
components.  
 
The substantial investment of Gasmet Technologies Oy in R & D is targeted at 
innovative, customer-driven solutions. Working closely with customers and global 
distribution network, the company offers extensive technical applications support 
services. Along with high reliability, the products of Gasmet Technologies Oy offer easy 
operation and consistent and accurate results, together with competitive pricing. 
 
The development of the powerful technology of FTIR has required uncompromising 
commitment and expertise in several fields of high technology. As a result, the products 
of Gasmet Technologies Oy are not only superior in performance, but also simple to 
operate and maintain. The continuing philosophy of Gasmet Technologies Oy is to 
provide reliable measurements in a variety of industrial applications now and in the 
future. 
 
Wherever you are and whatever your applications are, we hope you will find the 
Gasmet gas analyser and its accessories fast, accurate, reliable, and easy to use. 
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1 INTRODUCTION 
This instruction and operating manual provides information of the Gasmet DX4040 
Fourier transform infrared (FTIR) gas analyser. Please read this manual carefully and 
thoroughly prior to using the analyser. Improper use of the analyser may damage the 
equipment. 
 
Chapter 2 Supplied Goods provides general information regarding the content of the 
Gasmet DX4040 package. 
 
Chapter 3 Principle of Measurement discusses theoretical aspects of infrared 
spectroscopy. These fundamentals help understanding the physical principles the 
Gasmet FTIR system is based on. 
 
Chapter 4 Gasmet DX4040 FTIR Gas Analyser provides information about the 
Gasmet DX4040 hardware, the intended use of the equipment, technical specifications 
and equipment ratings. 
 
Chapter 5 Equipment Installation provides information of installing the Gasmet 
DX4040 gas analyser and specific commissioning instructions. Additionally, warnings 
against hazards, which could arise during installation or commissioning of the 
equipment, are given. Use this chapter to get the equipment from storage into 
operational condition. 
 
Chapter 6 Equipment Operation provides instructions on how to use the Gasmet 
DX4040. This chapter is recommended to read before any operation. 
 
Chapter 7 Equipment Maintenance and Service describes the maintenance and 
inspection of the equipment that are necessary periodically. 
 
Chapter 8 Analyser Inspection describes what should be done when the analyser is 
used the first time. This chapter includes an inspection sheet, which should be filled in 
within 30 days from the date of delivery to ensure that the warranty is valid in full. 
 
 
This instructions manual is copyrighted 2005 - 2014 by Gasmet Technologies Oy. 
All rights reserved. No part of this manual may be reproduced in whole or in part 
in any form without a prior written permission by Gasmet Technologies Oy. 
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2 SUPPLIED GOODS 

2.1 Package 

Gasmet DX4040 is shipped in a wooden box or in a dedicated transport case (optional). 
To open the box, first open the lid of the box. Remove any additional smaller items on 
the top of the analyser. Finally lift the analyser out of the box. A laminated paper 
describing the list of items delivered with Gasmet DX4040 is included in the shipment. 
Please, check that all the items ordered are included in the package and report to 
Gasmet Technologies Oy if some parts are missing. 

2.2 List of Items Delivered for DX4040 

The standard package contains: 
 
• Gasmet DX4040 FTIR gas analyser. 
• One DX4040 carrying kit (including carrying harness, adjustable shoulder strap, 

PDA carrying case, battery carrying case and four rubber straps). 
• One Gasmet battery for DX4040. 
• One serial to USB converter. 
• One AC/DC PSU for DX4040. 
• One serial cable for DX4040. 
• One power supply cord. 
• One PDA + Charger running Windows Mobile 6.1. 
• One sample probe with one 1.5 m Tygon® tube including two inserts, one 5 m 

Tygon® tube, three coupling inserts and one set of probe filters (five pieces). 
• One Gasmet DVD-ROM including:  

1. Application Tools folder (ADS application tools and Gasmet Tools application 
tools) 

2. Gasmet Software folder 
a) Calcmet Lite setup 
b) Calcmet v12.xx setup 

3. Quality Documents folder (ISO 9001 Certificate) 
4. User Manuals folder 

a) Gasmet DX4040 FTIR Gas Analyser Instruction and Operating Manual 
b) Calcmet User Manual 

5. Calcmet LiteLibrary folder, which includes 
a) instrument-specific reference files 
b) reference spectra Excel sheet (description of the reference spectra) 
c) library and configuration files for analyser, components file for Calcmet Lite 

6. Test folder (factory-measured SNR spectra, background spectra, and .ini file). 
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The options available are:  
 
• Coupling insert for DX4040 in the analyser end. 
• Transport case designed for DX4040. 
• External battery charger for DX4040 including external charger, USB cable and 

AC/DC PSU. 
• Additional AC/DC PSU. 
• Additional Gasmet batteries. 
• Additional set of filters. 
• Additional serial cable. 
• DX40XX PRO key for Calcmet software. 
• Additional serial to USB converter. 
• PTFE probe filter for DX4040. 

2.3 Gasmet Configuration 

The following functions have been factory set up in accordance with customer order 
specification:  
 

• Installation of software and analysis options in Calcmet Lite software. 
• Library and analysis options in Calcmet library if the PRO Key option ordered. 
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3 PRINCIPLE OF MEASUREMENT 

3.1 Principles of Infrared Spectroscopy 

Infrared (IR) spectroscopy is a technique for chemical analysis and determination of 
molecular structure in solid, liquid, and gas state. The principles that molecular 
vibrations occur in the infrared region of the electromagnetic spectrum and functional 
groups in chemical compounds have characteristic absorption frequencies are the basis 
of this technique. The frequencies of the most interest range from 2.5 to 16 µm. 
However, in IR spectroscopy it is common to use the reciprocal of the wavelength, 
called 'wave number', and thus this range becomes 4000 - 625 cm-1. 
 
An absorption spectrum demonstrates graphically to what extent the sample gas 
absorbs the different wavelengths of the infrared radiation. The spectrum shows the 
transmission of the infrared radiation through the gas as a function of wavelength. For 
each wavelength, the transmittance T is the intensity of the infrared radiation that has 
passed through the sample gas divided by the intensity of the infrared radiation that has 
entered the sample gas. When there is no absorption, the value of transmittance T is 1 
(or 100 %), which indicates that 100 % of the infrared radiation at that wavelength goes 
through the sample gas. If the intensity of the radiation entering the sample is I0 and the 
intensity of the radiation that has passed through the sample is I, the transmittance T is:  
 
 
 

  
 

 
 
 
 
 
 
Besides using transmittance T, the absorbance scale presents the absorption of the 
infrared radiation. Absorbance A is equal to the logarithm of the transmittance 
reciprocal:  
 
 
 

 
 
 
 

 
 
 
The advantage of using the absorbance scale is that the value of absorbance is directly 
proportional to the thickness of the sample gas (absorption path length), and the 
concentration of the sample gas. 
 

T = I / Io,  
 
T = transmittance 
I = passed intensity 
I = incident intensity 

A = log10(I / T),  
 
A = absorbance 
T = transmittance 
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Figure 1 shows how a carbon dioxide CO2 molecule behaves when it interacts with 
infrared radiation. All different vibrations, rotations, and their combinations result in 
absorption bands of specific wavelengths of the infrared radiation. 
 
 

 

 
Figure 1. The four normal modes of vibration of carbon dioxide CO2 molecule. 

 
 
The infrared absorption spectrum is unique to all different gas molecules. It is possible 
to identify any gas component from its IR spectrum. Figure 2 shows a carbon dioxide 
CO2 infrared absorbance spectrum. It can be seen that the anti-symmetric vibration 
band at 2349 cm-1 is the most intensive band while others are either outside of the 
range (900 - 4220 cm-1) or too weak in intensity. The band at ~3660 cm-1 is the 
combination band (i.e. sum) of υ1 and υ2. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Symmetric stretch υ1 at 1388 cm-1 
(This mode is not infrared active) 

Anti-symmetric stretch υ3 at 2349 cm-1 

In-plane bend υ2 at 667 cm-1 
 

Out-of-plane bend υ2 at 667 cm-1 

     O            C             O 
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Figure 2. An absorbance spectrum of carbon dioxide CO2 measured with a DX-4015 
model. c(CO2) = 50 ppm, T = 50 oC, absorption path length = 9.8 m. 

3.2 Components of a Fourier Transform Infrared Spectrometer 

Figure 3 shows the basic parts that are typical for all non-dispersive FTIR 
spectrometers. A parallel, polychromatic radiation from an IR source is directed to an 
interferometer. The modulated beam is reflected through the gas sample cell. Finally, 
the detector detects the intensity of the infrared beam. The detected signal is digitized 
and Fourier transformed by the computer resulting in an IR spectrum of the sample gas. 
 
 

 

 
Figure 3. The basic components of an FTIR spectrometer are infrared source, 
interferometer, sample cell, detector, and signal and data processing unit. 

 

Infrared 
source 

Interferometer Detector 
Signal and 

data processing 
unit 
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cell 
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The unique part of an FTIR spectrometer is the interferometer. Figure 4 shows a 
Michelson type interferometer. A mirror collects and collimates the infrared radiation 
from the source before it strikes the beam splitter. The beam splitter ideally transmits 
one-half of the radiation, and reflects the other half. Both transmitted and reflected 
beams strike plane mirrors, which reflect the two beams back to the beam splitter. 
Thus, one-half of the infrared radiation that finally goes to the sample gas has first been 
reflected from the beam splitter onto the moving mirror, and then back to the beam 
splitter. The other half of the infrared radiation going to the sample gas has first gone 
through the beam splitter and then reflected from the fixed mirror back onto the beam 
splitter. When these two beams from two optical paths are reunited, interference occurs 
at the beam splitter. The strength of the interference is depended on the optical path 
difference between the beams caused by the position of the moving mirror. 
 
 

Source

Beamsplitter

Radiation to the sample gas and detector

Moving mirror

Fixed mirror

 
 

Figure 4. A Michelson interferometer is a unique part of an FTIR spectrometer. 

 
The optical path length difference (OPD) between the two optical paths of a Michelson 
interferometer is two times the physical displacement of the moving mirror. An 
interferogram is the interference signal measured by the detector as a function of the 
OPD. Figure 5 shows a typical interferogram produced by the interferometer. The graph 
shows the intensity of the infrared radiation as a function of the displacement of the 
moving mirror. At the peak position, the optical path length is the same for the radiation 
that comes from the moving mirror as it is for the radiation that comes from the fixed 
mirror. 
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Figure 5. A typical interferogram. 

 
The spectrum is computed from the digitized interferogram by performing a Fourier 
transform by a computer utilizing a Fast Fourier Transform (FFT) algorithm. 

3.3 Quantitative Analysis of FTIR Spectra 

The basic law for spectroscopic quantitative analysis is Beer's law (also known as the 
Beer-Lambert law). It shows how the concentration of the sample gas is related to the 
measured absorbance of the sample spectrum:  
 

 
log( / ) log( / )I I T A abc0 1= = =  
 
Io = intensity of infrared radiation entering the sample 
I = intensity of the infrared radiation that has passed through the sample 
A = absorbance 
T = transmittance 
a = a (υ) = absorptivity (depends on wavelength) 
b = optical path length 
c = sample concentration 
 

 
The absorptivity a characterizes the capacity of the molecule to absorb infrared 
radiation. The value of a varies from a molecule to another and as a function of 
wavelength, but is constant for a given molecule at a given wavelength. The quantity b 
is the optical path length, that is, the distance the infrared radiation beam traverses in 
the gas sample. The quantity c indicates the concentration of the sample gas molecules 
in the sample. If the optical path length is constant, Beer's law states that the 

V
ol

ta
ge

 U
 (m

v)
 

Optical path difference x/2 (cm-1) 

         - L                                0                             + L 
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pV = nRT, 
 
p = pressure 
V = volume 
n = number of gas molecules 
R = gas constant = 8.314 JK-1mol-1 
T = temperature 

absorbance is directly proportional to the concentration of the sample gas at a given 
wavelength. Since Beer's law is additive, the total absorbance A is equal to the sum of 
the values of A of each gas component. 
 
Two conditions limit the use of the Beer's law in practice. The radiation is 
monochromatic, and the sample absorptivity does not vary with concentration. If the 
sample concentration range is wide, the change in the sample environment can cause 
absorptivity changes and deviations from Beer's law. For narrow concentration ranges 
and for low absorbance values a plot of concentration versus absorbance is nearly 
linear. 
 
The changes in the gas pressure caused by molecular collisions may bring about 
broadening in the absorption line shape of the sample gas. This affects all infrared 
bands. As the temperature increases, the population distribution of the molecules in 
different energy levels changes. The changes in the temperature cause changes in the 
absorption line shape of the sample gas. To measure the concentration of a gas 
compound, it is necessary to calculate the number of gas molecules in the sample cell. 
The number of the gas molecules in the sample cell depends linearly on both the gas 
pressure and the volume of the sample cell, and reciprocally on the gas temperature 
(ideal gas equation of state):  
 
 
 
 
 
 
 
 
 
 
Any changes in sample gas temperature and/or pressure in the sample cell directly 
affect the measured gas compound concentration. In addition, gas pressure or 
temperature changes may affect the line shape of the measured absorbance spectrum, 
and thus the accuracy of the analysis results. 

3.4 Multi-component Analysis 

The degree of absorption of infrared radiation at each wavelength relates quantitatively 
to the number of absorbing molecules in the sample gas. Since there is a linear 
relationship between the absorbance and the number of absorbing molecules, 
quantitative multi-component analysis of gas mixtures is feasible. 
 
To perform multi-component analysis we need a sample spectrum. In addition, we need 
reference spectra of all the gas components that may exist in the sample. A reference 
spectrum is a spectrum of one single gas component of specific concentration. In multi-
component analysis, we try to combine these reference spectra with appropriate 
multipliers in order to get a spectrum that is as close as possible to the sample 
spectrum. If we succeed in forming a spectrum similar to the sample spectrum, we get 
the concentration of each gas component in the sample gas using the multipliers of the 
individual reference spectra, if we know the concentrations of the reference gases. 
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For example, suppose we have a sample spectrum and reference spectra like those 
shown in Figure 6. In this case, we know that the sample gas consists of gases 
Reference 1 and Reference 2. We have the reference spectra available and we know 
that these reference spectra represent concentrations of 10 ppm and 8 ppm, 
respectively. To find out the concentration of each component in the sample gas, we try 
to form the measured sample spectrum using a linear combination of the two reference 
spectra. We find out that if we multiply the spectrum Reference 1 by 5 and the 
spectrum Reference 2 by 2, and combine these two spectra we get a spectrum that is 
similar to the sample spectrum. Accordingly, the sample gas contains reference gas 1 
at five times the amount in the reference spectrum 1, and reference gas 2 at two times 
the amount in the reference spectrum 2. The analysis indicates that the sample indeed 
consists of these two reference gases. The concentration of the reference gas 1 in the 
sample is found to be 50 ppm (= 5 x 10 ppm), and the concentration of the reference 
gas 2 in the sample is 16 ppm (= 2 x 8 ppm). 
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Figure 6. An example of spectra for multi-component analysis. The spectral analysis 
routine in Calcmet Lite software performs all calculations automatically. 

3.5 The Spectral Resolution of FTIR Analysis 

The spectral resolution of the measurement indicates how accurately it is possible to 
separate different wavelengths of radiation in the absorption spectrum. High resolution 
allows one to detect visually the exact location of narrow absorbance peaks and 
reduces spectral overlap. If it were possible to achieve infinite resolution, no deviations 
of Beer's law due to wide concentration range would occur. Thus, it would seem 
beneficial to have high resolution in order to get good results for the analysis. However, 
increasing the resolution causes other problems. For example, spectral noise increases 
and makes the analysis less precise. 
 
Furthermore, as high a resolution as possible does not maximize the information 
content of the measurement. Jaakkola et al. have shown1 that low-resolution FTIR 
spectroscopy offers some valuable advantages compared to the traditional high-
resolution FTIR gas phase spectroscopy, especially in non-laboratory environments. 

1 See, for example, P. Jaakkola, J. D. Tate, M. Paakkunainen, J. Kauppinen, and P. Saarinen, "Instrumental Resolution Considerations for 
Fourier Transform Infrared Gas-Phase Spectroscopy," Applied Spectroscopy 51 (1997) 1159 - 1169. 
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This makes the use of low resolution quite worthwhile. To achieve precise quantitative 
analysis results, a low-resolution measurement should be used if the spectral analysis 
program can mathematically solve the spectral overlap. 
 
There are two reasons for the increase of the signal-to-noise ratio of an FTIR spectrum: 
 
• In an FTIR spectrometer, the length of the measured interferogram determines the 

resolution. The longer the interferogram, the more data points is required, and the 
higher the resolution. In a high-resolution study, the time required by a single 
measurement is also long, so that we are able to accumulate less data in a fixed 
time, leading to higher noise level. Thus, the longer the measured interferogram is, 
the lower the signal-to-noise ratio.  

• High resolution requires a small aperture to prevent a phenomenon called aperture 
broadening. Small aperture, in turn, reduces the signal and thus signal-to-noise 
ratio. 
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4 GASMET DX4040 FTIR GAS ANALYSER 

4.1 Introduction 

The Gasmet gas analysers are divided into four categories: On-line/CX- and FCX-
Series, On-site/DX-Series, In-lab/CR-Series, and In-situ-Series depending on their 
properties and customers' application. All Gasmet analysers incorporate a Fourier 
transform infrared (FTIR) spectrometer, a temperature-controlled sample cell (except 
DX4030 and DX4040 models), and signal processing electronics. The analyser offers 
versatility and high performance for all users. 
 
The Gasmet On-site/DX-Series includes the DX4000, DX4015, DX4030 and DX4040 
models, which all are portable multi-component gas analysers for demanding industrial 
applications. The Gasmet DX-Series is designed for on-site measurements. It is an 
ideal tool to measure trace concentrations of pollutants in wet, corrosive gas streams. 
The sample cell maximum temperature is 180 °C (210 °C in a special configuration) in 
the DX4000, 50 °C in the DX4015 and ambient for the DX4030 and DX4040 model. 
Sample cell absorption path length is selected according to the application and model. 
 
The DX4040 model analyser is designed for on-site measurements of various organic 
and inorganic compounds at low concentrations in ambient air. Typical usage areas 
include industrial hygiene and emergency response situations after incidents involving 
toxic chemical compounds. Analysis results of up to 25 pre-calibrated compounds are 
displayed on screen of an industrial-grade PDA. Optionally, the analyser can be 
connected to a laptop PC for extended analysis capability (e.g. identification of 
unknown compounds with library spectra). The key features of the Gasmet DX4040 
include a high sensitivity sample cell for lowest possible detection limits and a built-in-
pump, which means that there is no need to use a separate sampling system. 
 
There are no consumable parts that would need to be replaced on regular basis. In 
addition, due to FTIR technology, the calibrations remain very stable. Hence, no span 
calibrations are needed. In addition, cross-references (i.e. interferences with other 
gases) are automatically compensated in the analysis algorithm during the calculation 
of the results. 

4.1.1 Applications of the Gasmet DX4040 Analyser 

The Gasmet DX4040 analyser enables identification and quantification of multiple 
gaseous compounds simultaneously and accurately, with results available in seconds. 
The Gasmet DX4040 is a versatile gas analyser that can be used in several 
applications. It is specially designed for:  
 
• Industrial hygiene 
• Emergency response 

4.1.2 Structure of the Gasmet DX4040 Analyser 

Figure 7 outlines the structure of a DX4040 gas analyser. The infrared source produces 
broadband radiation, which interferometer modulates. The interferometer actually 
performs an optical inverse Fourier transform of the infrared radiation emitted by the 
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infrared source. The modulated infrared radiation passes through the sample cell where 
sample gas absorbs certain wavelengths of the radiation. The detector detects the 
transmitted infrared radiation. The A/D converter digitizes the signal. The on-board 
digital signal processor (DSP) performs a mathematical Fourier transform on the 
digitized interferogram resulting in a spectrum.  
 
Fast Fourier Transform (FFT) is used to compute the spectrum from the interferogram. 
The FFT result is a transmittance spectrum. The absorbance spectrum is the ratio of 
the sample spectrum (transmittance spectrum) to the background spectrum. (The 
absorbance spectrum is computed from the transmittance spectrum). Gasmet uses the 
Calcmet Lite software to display the concentrations of the components present in the 
sample gas from the absorbance spectrum. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7. Basic structure of the Gasmet DX4040 analyser. 

 
The data and signal processing electronics control the operation of the analyser. A PDA 
is used as a master device to communicate with the Gasmet DX4040 analyser. 
 
A unique part of the analyser is the Gasmet Technologies Oy's GICCOR (an acronym 
for 'Genzel interferometer with a cube corner retroflector') interferometer. It is rugged 
and withstands the demanding environmental conditions of non-laboratory environment. 
The GICCOR interferometer modulates the infrared radiation coming from the infrared 
source, as discussed previously. 
 

4.2 Gasmet DX4040 Technical Specifications 

4.2.1 General Parameters 

It is recommended that all instruments operate in the following environmental 
conditions:  
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Measurement principle:  FTIR (Fourier Transform Infrared) spectroscopy 
Performance:  Simultaneous analysis of up to 25 gas compounds (PDA), 

50 gas compounds with optional Calcmet software 
Response time, T90:  Typically < 120 s, depending on the gas flow and 

measurement time 
Operating temperature:  Ambient temperature 
 Short term 0 - +40 °C 

Long term +5 - +30 °C 
< 90 % relative humidity, non-condensing 

Storage temperature:  10 - 35 °C, non-condensing, dry place (battery: store at 15 -
50 % state of charge with temperature preferably not 
exceeding +30 °C) 

Shipping temperature:  -20 - 45 °C during 12 hours, non-condensing 
Power supply:  Battery: 11.25 VDC lithium-ion battery 153.0 Wh 

AC/DC PSU: 100 - 240 VAC, 50 - 60 Hz 120W 
Analyser supply:  DC supply 15V – 20V DC 100W MAX. 
Battery functioning time:  Approximately 2.5 hours operation time with Bluetooth ON 

(dependent of ambient temperature) 

4.2.2 Spectrometer 

Interferometer:  Gasmet Technologies Oy’s GICCOR interferometer 
Resolution:  8 cm-1  
Scan frequency:  10 scans / s 
Aperture:  1’’ 
Detector:  Peltier cooled mercury cadmium telluride (MCT) detector 
Infrared source:  Ceramic (SiC), at 1550 K temperature 
Beam splitter:  ZnSe 
Optical window material:  ZnSe 
Wave number range:  900 – 4200 cm-1 with ZnSe/MCTP 
Laser: Helium-neon laser tube, maximum output power: ≥ 0.8 mW, 

wavelength: 632.8 nm. Laser safety information is available 
in appendix. 

4.2.3 Sample Cell 

Structure:  Multi-pass; fixed path length 9.8 m 
Material:  100 % rhodium coated aluminium 
Mirrors:  Fixed, protective gold coating 
Volume:  0.4 litres 
Connectors (front panel):  Festo 6 mm push-in fittings for SAMPLE IN, SAMPLE OUT, 

ZERO IN and interferometer PURGE 
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Gaskets:  Viton O-rings (both Teflon coated Viton O-rings and 
Kalrez coated Viton O-rings are optional) 

Temperature:  Ambient 
Max. sample gas pressure:  Ambient pressure 
Response time:  < 30 seconds 
Required gas filtration:  Filtration of particulates [two (2) microns)], (included in 

standard probe)  
Sample gas condition:  Non-condensing 
 

4.2.4 Measuring Parameters 

Zero point calibration:  24 hours calibration with nitrogen (5.0 or higher N2 
recommended) 

Zero point drift:  2 % of smallest measuring range per zero-point calibration 
interval 

Sensitivity drift:  None 
Linear derivation:  2 % of smallest measuring range 
Temperature drift:  2 % of smallest measuring range per 10 °C change, 

temperature measured and compensated 
Pressure influence:  1 % change of measuring value for 1 % sample pressure 

change, ambient pressure changes measured and 
compensated 

 

4.2.5 Electrical Connectors 

Digital interface:  Bluetooth protocol for communication in between the 
analyser and PDA (measurements and control of DX4040).  
RS232, 9-pole D-connector for communication in between 
the analyser and PDA (measurements and control of 
DX4040). 
RS232, 9-pole D-connector for communication in between 
the analyser and computer (measurements and control of 
DX4040) using optional Calcmet 4040 PRO software. 

Power connection:  Power supply cord. 
 

4.2.6 Gas Inlet and Outlet Conditions 

Gas temperature:  Ambient temperature (0 - 50°C), non-condensing. 
Gas filtration:  Filtration of particulates (2 µm) required, (included in 

standard probe) 
Sample gas pressure:  Ambient 
Sample pump:  Internal pump. Flow ~1.5 l/min, for ambient air only 
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4.2.7 Electronics  

A/D converter:  Dynamic range 95 dB 
Signal processor:  32 bit floating point DSP 
 

4.2.8 Analysis Software 

PDA:  Gasmet Portable Device Assistant 
Operating system:  Microsoft Windows Mobile 6.1 
Analysis software:  Calcmet Lite v2.0 
Optional software (PC):  Calcmet software with DX40XX PRO key: analysis of 

spectra, live measurement. Laptop PC + Windows XP 
required. 

 Microsoft ActiveSync® in order to synchronize files in 
between PDA and computer PC using USB connector. 

 

4.2.9 Additional Information 

Enclosure:  Polyurethane 
Dimensions (mm):  406 * 390 * 161 
Weight:  13.8 kg (with battery), 12.4 kg (without battery) 
Altitude: 0 m up to 2000 m 
Sound level: 70 dBA maximum. 
Standards:  EN 61326-1: 2006. 
 EN 300 328 V1.7.1: 2006. 
 EN61010-1:2010. 
 EN 60825-1:2007 
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4.3 Gasmet DX4040 Technical Description 

4.3.1 Analyser Enclosure 

DX4040 specially designed enclosure is made of polyurethane, material used for hard-
plastic parts. In order to comply with EMC (Electromagnetic Compatibility), the 
enclosure receives a thin layer of copper coating. 
 
The dimensional drawing of Gasmet DX4040 is shown in Figure 8. 
. 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

 

Figure 8. Dimensional drawing of the DX4040 analyser enclosure. 
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4.3.2 Power Supply 

Only a Gasmet specified battery or a Gasmet specified AC/DC PSU must be used 
with DX4040 analyser. 

4.3.2.1 Battery 

The DX4040 analyser uses 11.25 VDC state of the art lithium ion rechargeable battery 
with SMBus features and LED display. It has a rated energy of 153 Wh that leads to a 
functioning time of two and a half hours depending of external temperature. The lower 
the temperature is, the shorter the functioning time especially with temperatures below 
5 °C. 
 
As the available energy per hour of the battery is quite high, this battery is submitted to 
strict legislation regarding battery shipping. Those batteries benefit of a transportation 
certificate specifying that the batteries meet the requirements of the UN 
Recommendations on the transport of dangerous goods, Part III, sub-section 38.3. 
Depending upon the transportation, the batteries are shipped according to the country 
of shipment, rules on dangerous goods. The shipper is solely responsible for proper 
packaging of the batteries. It is strongly advised to contact the shipping company in 
your own country before shipping battery in order to ensure correct and safe shipping. 
 
The battery is compliant with the Smart Battery standard. Charge indicator LEDs are 
visible on the front end of the battery as well as a push button. Use the push button in 
order to monitor the status of charge of the battery. Batteries can be charged or 
discharged at the same temperatures than the analyser operating temperature 0 - 40 
°C). Batteries can be charged inside the analyser in the same time than the analyser is 
functioning using the AC/DC PSU at the expense of a longer charge time as the supply 
is split in between the analyser and the battery charge. When the analyser is switched 
off and the battery needs to be fully charged, the charge time is less than five hours. 
This charge time is more or less similar on the entire operating temperature range. 
 
Batteries are recommended to be charged at ambient temperature. If a battery is too 
cold (less than 0 °C) or too warm (more than 50 °C), charge of the battery is discarded 
by the embedded charger in order to prevent possible damages to the battery. If the 
battery voltage is too low (below +9 V) and the DX4040 is switched ON only under 
battery mode, the analyser will remain off in order to prevent voltage depletion and 
damage to the battery. For best performance, keep the battery within 15 - 50 % of full 
charge for long-term battery storage. 
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The status of battery LEDs is specified below (Figure 9):  
 
 
 
 
 
 
 
 
 
 

 

Figure 9. Battery LED indicator. 
 
When the button located on the battery side is pushed, user can monitor the absolute 
state of charge of the battery. Each LED represents 20 % of battery charge. If the 
battery state of charge is below or equal to 10 %, the red LED blinks showing the user 
that battery should be recharged. 
 
For more information regarding battery use, please refer to Chapter 5, appendix C and 
appendix D. 

4.3.2.2 AC/DC PSU 

A 120-watt AC/DC PSU is used to power the DX4040 and to charge the battery. The 
required mains input is from 100 VAC up to 240 VAC, 50 Hz- 60 Hz. Hold-up time of the 
analyser is 20 ms from loss of AC input.  
 
Refer to Chapter 5 for proper supply of the analyser. 

4.3.2.3 Fuses 

The AC/DC PSU has an internal resettable fuse. Any error condition will blow the 
internal fuse. The fuse will automatically reset after the fault condition is corrected. If 
the AC/DC PSU is potentially damage, please contact Gasmet before starting any 
maintenance. 
 
Battery is overcharge, over discharge and over current protected in order to prevent 
possible damage or potential explosion. The overcharge and over discharge protection 
by cell voltage control is reversible; the fuse protecting against overcurrent is 
irreversible. Reversible protection of the battery is reversed by applying +12V DC 
voltage on battery power supply pins (Pin 1: Batt- and Pin 2: Batt+). 

Push button 

   0%     20%    40%     60%    80% 
  20%    40%    60%     80%    100% 
 CHARGED 
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4.3.3 Front Panel 

DX4040 front panel (Figure 10) gathers all functionalities of the analyser: gas 
inlets/outlet fittings, DC power supply input, cable connection, power switch, LEDs and 
Bluetooth module. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10. Front panel: sample gas fittings and connectors of the DX4040 model. 

4.3.3.1 Gas Fittings 

All gas connectors in the DX4040 analyser are grouped together on the front panel. The 
quick-connect fittings accept 6 mm OD PTFE or PFA tubing and the Gasmet 6 mm tube 
adapter, which allows the use of more flexible tubing such as Tygon. The quick-connect 
fittings engage the tube when the tube is pushed in, and the tube is released by 
pressing the blue plastic collar while pulling the tube gently. The connectors for 
SAMPLE IN, ZERO GAS IN and SYSTEM PURGE have check valves, which shut off 
when the tube is uncoupled. The SAMPLE OUT connector has no valve and remains 
open when uncoupled. A rotary connector cover protects the fittings when the DX4040 
is not used. 
 
Ensure that a sample tube is connected to SAMPLE IN connector before starting the 
sample pump! 
 
The sample gas connectors are (Figure 10):  
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• SAMPLE IN: Connection of the sample gas inlet. Internal pump will pump the 

sample gas from this inlet. 
• SAMPLE OUT: Sample gas outlet permanently opened. 
• ZERO GAS: Connection of zero/span gas inlet for background or span 

measurement. Pump should be switched off for proper background 
measurement. 

• SYSTEM PURGE: Connection of a low flow (0.5l/min) zero gas inlet in order to 
purge interferometer and focusing optic. This option can be used for high 
accuracy measurements. Only N2 or dry and clean instrument air should be used 
to purge the analyser. 

 
Follow the instructions below (Figure 11) in order to connect/disconnect 6 mm OD 
PTFE, PFA tube or Gasmet Tycon tube adapter to/from the quick-connect fittings: 
 
To connect a tube to the analyser 

1. Rotate the protective rotary connector cover by lifting the cover and rotating it 45 
degrees to either direction and then releasing it. 

2. Insert a tube to the appropriate inlet/outlet by pushing the tube as far as it goes 
into the connector. 

 
 
 
 
 
 
 
 
 

Figure 11. Gas fittings. 

 
To disconnect a tube from the analyser 

1. Push the blue connector collar downwards with thumb and index finger and 
simultaneously pull the tube upwards. 

2. Rotate the protective rotary connector in order to cover the connectors if 
necessary. 

 

4.3.3.2 Power Inlet 

An IP68 protective cover protects the power inlet from the dust and the humidity. 
Remove this cover to access the power inlet connector using Gasmet AC/DC PSU. 
Only Gasmet AC/DC PSU are recommended for DX4040 operation. AC/DC PSU 
should only be used indoor. Check “Power Supply: AC/DC PSU” chapter for further 
information. 
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4.3.3.3 Communication Inlet 

DX4040 is operated with Calcmet Lite software on PDA. Communication between PDA 
and analyser uses either Bluetooth or RS232. Optionally, DX4040 can be operated with 
Calcmet 4040 PRO via RS232. 

4.3.3.3.1 Bluetooth Communication 

Bluetooth communication is used to measure and/or record spectra in real time. It is 
used as well to display and record analysis results. Start-up of the analyser can also be 
made by Bluetooth using PDA when the power switch is in Bluetooth mode. 
 

4.3.3.3.2 RS232 Interface 

RS232 interface (Cable) can also be used for communication between the DX4040 and 
the PDA using the provided Gasmet DX4040 serial cable. RS232 interface also allows 
connection to an external computer in order to realize live measurements using the 
optional Calcmet PRO. An IP68 protective cover protects the cable inlet from the dust 
and the humidity. Remove this cover to access the RS232 communication inlet 
connector using the provided Gasmet DX4040 serial cable. 
 

4.3.3.4 Power Switch and LEDs 

DX4040 is started up using the front panel power switch located in the top right end 
corner of the front panel. On the right side of the rotary switch, five LEDs mounted 
vertically display the status of charge of the battery. Those five LEDs display the similar 
information than the five LEDs located in the battery. Two extra LEDs (ON Cable and 
ON Bluetooth) located close to the rotary switch inform of the mode of operation of the 
analyser. 
 
Using the power switch, three modes of operation are possible: 

- Power switch in Off mode (ON Cable LED and ON Bluetooth LED OFF). 
- Power switch in Cable mode (ON Cable LED ON and ON Bluetooth LED OFF). 
- Power switch in Bluetooth mode (ON Cable LED OFF and ON Bluetooth LED 

ON). 
 

4.3.3.4.1 Power Switch in Off Mode 

 In this mode, if the battery is inserted into the analyser and if the AC/DC PSU is not 
connected or not powered, the DX4040 is not powered and no current is drawn from 
the battery. If the AC/DC PSU is connected and powered, the embedded charger is 
powered displaying the status of charge of the battery. ON Cable LED and ON 
Bluetooth LED remain OFF. Table 1 below sums up the different options possible when 
power switch is in Off mode. 
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Option Current LED Analyser Charge of 

battery 
Battery not connected + 
AC/DC PSU not connected 

No current 
drawn 

OFF – Nothing displayed OFF OFF 

Battery connected + AC/DC 
PSU not connected 

No current 
drawn 

OFF – Nothing displayed OFF OFF 

Battery connected + AC/DC 
PSU connected to mains + 
battery fully charged 

Small current 
drawn coming 

from mains 

ON – Relative state of charge of the 
battery displayed. ON Cable LED 

OFF. ON Bluetooth LED OFF 

OFF OFF 

Battery connected + AC/DC 
PSU connected to mains + 
battery requires charge 

Big current 
drawn coming 

from mains 

ON – Charge status of the battery 
displayed. ON Cable LED OFF. ON 

Bluetooth LED OFF 

OFF ON 

Battery not connected + 
AC/DC PSU connected 

Small current 
drawn coming 

from mains 

ON – Battery error displayed because 
no battery connected. ON Cable LED 

OFF. ON Bluetooth LED OFF 

OFF OFF 

Table 1. Power switch in Off mode. 

4.3.3.4.2 Power Switch in Cable Mode 

In this mode, if the battery is inserted in the analyser and if the AC/DC PSU is not 
connected or connected but not powered, the DX4040 is powered by the battery and 
the analyser starts up. If the AC/DC PSU is connected and powered, the DX4040 starts 
up powered by mains supply. The embedded charger is in both cases powered and 
LEDs are on. Of course, if no battery and no AC/DC PSU are present, then, the 
DX4040 is not powered at all. Table 2 below sums up the different options possible 
when power switch is in Cable mode. 
 

Table 2. Power switch in Cable mode. 

 Current LED Analyser Charge of battery 
Battery not connected + 
AC/DC PSU not connected 

No current drawn OFF – Nothing 
displayed 

OFF OFF 

Battery connected + AC/DC 
PSU not connected 

Big current drawn 
coming from 

battery 

ON – Relative state of 
charge of the battery 
displayed. ON Cable 

LED ON. ON Bluetooth 
LED OFF 

ON OFF 

Battery connected + AC/DC 
PSU connected to mains + 
battery fully charged 

Big current drawn 
coming from 

mains 

ON – Relative state of 
charge of the battery 
displayed. ON Cable 

LED ON. ON Bluetooth 
LED OFF 

ON OFF 

Battery connected + AC/DC 
PSU connected to mains + 
battery requires charge 

Big current drawn 
coming from 

mains 

ON – Charge status of 
the battery displayed. 

ON Cable LED ON. ON 
Bluetooth LED OFF 

ON ON 

Battery not connected + 
AC/DC PSU connected 

Big current drawn 
coming from 

mains 

ON – Battery error 
displayed because no 
battery connected. ON 

Cable LED ON. ON 
Bluetooth LED OFF 

ON OFF 
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4.3.3.4.3 Power Switch in Bluetooth Mode 

In this mode, if the battery is inserted in the analyser and if the AC/DC PSU is not 
connected or connected but not powered, the Bluetooth module is powered waiting for 
Calcmet Lite to start up before powering the analyser. If the AC/DC PSU is connected 
and powered, the DX4040 Bluetooth module is powered by mains supply and the 
analyser is powered only if Calcmet Lite is opened and Bluetooth connection is 
established correctly. The embedded charger is in both cases powered and LEDs are 
on. Of course, if no battery and no AC/DC PSU are present, then, the DX4040 is not 
powered at all. Table 3 below sums up the different options possible when power switch 
is in Cable mode. 
 

 
Option Current LED Analyser Charge of 

battery 
Battery not connected + 
AC/DC PSU not 
connected 

No current drawn OFF – Nothing 
displayed 

OFF OFF 

Battery connected + 
AC/DC PSU not 
connected 

Small current 
drawn – Waiting 

for Calcmet Lite to 
open 

ON – Relative state of 
charge of the battery 
displayed. ON Cable 

LED OFF. ON 
Bluetooth LED ON 

OFF if Calcmet Lite 
not started/On if 

Calcmet Lite 
connected 

OFF 

Battery connected + 
AC/DC PSU connected to 
mains + battery fully 
charged 

Small current 
drawn – Waiting 

for Calcmet Lite to 
open 

ON – Relative state of 
charge of the battery 
displayed. ON Cable 

LED OFF. ON 
Bluetooth LED ON 

OFF if Calcmet Lite 
not started /On if 

Calcmet Lite 
connected 

OFF 

Battery connected + 
AC/DC PSU connected to 
mains + battery requires 
charge 

Big current drawn 
coming from 

mains because 
battery needs to 

be charged 

ON – Charge status of 
the battery displayed. 
ON Cable LED OFF. 

ON Bluetooth LED ON 

OFF if Calcmet Lite 
not started /On if 

Calcmet Lite 
connected 

ON 

Battery not connected + 
AC/DC PSU connected 

Small current 
drawn – Waiting 

for Calcmet Lite to 
open 

ON – Battery error 
displayed because no 
battery connected. ON 
Cable LED OFF. ON 
Bluetooth LED ON 

OFF if Calcmet Lite 
not started /On if 

Calcmet Lite 
connected 

OFF 

Table 3. Power switch in Bluetooth mode. 

 

4.3.3.4.4 LED Display 

Front LED panel displays relative state of charge of the battery when one battery is 
inserted into the analyser. This display allows also monitoring the charge status and 
errors from battery/charger. The tables 4 - 11 below list the different possible LED 
information schemes. 
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Table 4. Battery relative state of charge status. 
 
 

Table 5. Battery charging – LED status. 

 

Table 6. Battery relative state of charge status (0 % to 10 %). 

 

Table 7. Battery disconnected. 

 

Table 8. Battery temperature or charger temperature not correct. 

 

 Battery relative state of charge status (% of full charge) 
10 – 20 % 
charged 

20 – 40 % 
charged 

40 – 60 % 
charged 

60 – 80 % 
charged 

80 – 100 % 
charged 

LED indicator status 
 
 
 
 
 

     

 Battery charge at time T 
T + 0 sec. T + 1,3 sec. T + 2,6 sec. T + 3,9 sec. T + 5,2 sec. T + 6,5 sec. 

LED indicator 
status if the battery 
is 30 % charged 
 
 
 

      

 Battery relative state of charge status (% of full charge) 
0 to 10 % charged 

T + 0 sec. 
0 to 10 % charged 

T + 1,3 sec. 
LED indicator status   

 Time 
T + 0 sec. T + 1,3 sec. 

LED indicator status 
Battery disconnected 
 
 
 
 

  

 Time 
T + 0 sec. T + 1,3 sec. 

LED indicator status 
Battery temperature or charger temperature 
not correct. 
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 Time 

T + 0 sec. T + 1,3 sec. 
LED indicator status 
AC/DC PSU error 
 
 
 
 

  

Table 9. AC/DC PSU error. 

 
 
 

 Time 
T + 0 sec. T + 1,3 sec. 

LED indicator status 
SMBus error 
 
 
 
 

  

Table 10. SMBus error. 

 
 Time 

T + 0 sec. T + 1,3 sec. 
LED indicator status 
Charger communicator error 
 
 
 
 

  

Table 11. Charger communication error. 

4.3.4 On-board Sample Pump 

The DX4040 model is equipped with an on-board sample pump, which has a neoprene 
diaphragm membrane. Pump power supply is +12 VDC, maximum pressure is 1.0 bar 
and maximum flow is 2.0 l/min. 
 
The sample gas of DX4040 should be at ambient temperature and no condensing. 

4.3.5 On-board Fans 

Three fans allow correct dissipation of DX4040 internal temperature. Two fans 
assembled on specific positions of the enclosure establish airflow inside the analyser in 
order to cool down parts and evacuate internal heat. The speed of those two fans is 
controlled on a linear way depending of the DX4040 internal temperature. Such control 
allows to reduce vibration, audible noise and decrease fans power consumption. An 
internal small fan dissipates main electronics heat. 
 
Two dedicated dust filters, accessible from the enclosure, prevent dust to enter inside 
the analyser while maintaining a correct airflow. Those filters should be as clean as 
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possible during DX4040 use in order to prevent extra heat. Dust filters provided by 
Gasmet are the only one usable. 
 
Care should be taken in order to ensure a correct airflow around the DX4040 and avoid 
fan obstruction. 
 
Instruction regarding the change of dust filters is detailed in the maintenance chapter. 

4.3.6 Probe 

DX4040 specifically designed light probe combines an embedded gas filter. Filter 
cleanliness is important to insure correct measurements. Filters provided by Gasmet 
Technologies Oy are the only one usable. 
Sample gas should be at ambient temperature and avoid sudden changes in ambient 
gas temperature in order to prevent condensation in sample cell. 
 
Follow the instructions below in order to connect/disconnect the Gasmet 6 mm tube 
adapter to/from the probe: 
 
To connect the tube to the probe: 

- Insert the 6 mm tube to the probe inlet by pushing the tube as far as it goes into 
the connector. 

 
To disconnect the tube from the probe: 

- Push the connector collar downwards with thumb and index finger and 
simultaneously pull the tube upwards. 

 
Instructions regarding the change of probe filters are detailed in the maintenance 
chapter. 

4.3.7 Carrying Handle, Shoulder strap and Carrying Harness 

A carrying handle is used to carry the analyser safely in vertical position. Alternatively, a 
shoulder strap can be used to carry DX4040 in vertical position by connecting the metal 
snap hooks onto DX4040 o-ring belt buckles. For backpack use, a specifically designed 
sturdy and adjustable carrying harness can be attached easily by connecting the metal 
snap hooks onto DX4040 o-ring belt buckles. 
 
Refer to Chapter 5 for proper carrying of the analyser. 

4.3.8 Personal Digital Assistant (PDA) 

DX4040 operates with a provided sturdy IP67 PDA running Gasmet proprietary 
software Calcmet Lite. This combination allows to operate the DX4040 and get 
concentration results in seconds using a Bluetooth connection in between the analyser 
and the PDA. A functioning range of maximum ten meters can be obtained in between 
analyser and PDA. 

4.3.9 Optional Computer 

Optionally, DX4040 operates with a laptop running Gasmet proprietary software 
Calcmet. This combination allows operating the DX4040, getting concentration results 
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and discovering unknown gas components by using a cable connection in between the 
analyser and the computer. 
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5 EQUIPMENT INSTALLATION 
During installation of the analyser, the safety of any system incorporating the 
equipment is the responsibility of the assembler of the system. 

5.1 Storage and Packaging Conditions 

The analyser must be stored in a dry and condensation-free place. Gasmet original 
package (wooden box) or optionally DX4040 transport case must be used to store the 
equipment. 
 
The following long-term storage conditions should be respected: 
 
• +10 - +35 °C storage temperature 
• 5 - 95 % relative humidity, non-condensing 
• Gasmet battery to be stored at 15 % to 50 % state of charge with an ambient 

temperature preferably not exceeding +30 °C. 
 
For short term storage, like for example during shipping, the following conditions can be 
tolerated: 
 
• -20 - +45 °C during 12 hours 
• 5 - 95 % relative humidity, non-condensing 
 
Do not drop the analyser even when stored in its original package (wooden box) 
or in its transport case. 
 
Keep the box and packaging materials, in case the unit needs to be returned for 
service. 

5.2 Operating Conditions 

5.2.1 Lifting and Carrying Instructions 

DX4040 can be lifted and carried safely in vertical position on three different ways: 
 

• Using the carrying handle. 
• Using the adjustable shoulder strap. 
• Using the adjustable carrying harness. 

 
Those carrying elements are capable of withstanding a force of four times the weight of 
the equipment. Care should be taken when using those different carrying elements and 
the user is responsible of the safekeeping of those elements. 
 
Never attach the metal snap hooks of the shoulder strap or the carrying harness 
in the same time onto DX4040 o-ring belt buckles. 
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Attach the adjustable shoulder strap onto the analyser by connecting the metal snap 
hooks onto DX4040 o-ring belt buckles. For backpack use, attach the adjustable 
carrying harness onto the analyser by connecting the metal snap hooks onto DX4040 o-
ring belt buckles. 
 
User should pay attention to attach correctly carrying harness or shoulder strap 
onto the O Ring Belt Buckles in order to prevent accidents. 

5.2.2 Installation Location 

The analyser must be installed, and operated in a dry and condensation-free 
place. The environment should be clean enough so that no dirt will accumulate 
on or inside of analyser. 
 
The installation location must be preferably free of strong vibrations. Shocks 
during transport, for example, can cause serious damage. When transporting the 
instrument, use the original wooden box or transport case with original shock 
absorbing materials. 
 
The equipment must not be operated in wet conditions. 
 
Locate the AC/DC PSU so that the appliance coupler of it is easily reachable. The 
socket outlet to which the AC/DC PSU is connected shall be in vicinity of the 
equipment and easily reachable. 
 
Disconnect the equipment from mains by mains plug from AC/DC PSU. 
 
Refer to chapter “Gasmet DX4040 Technical Specifications” for further information. 
 
In some cases, large temperature changes may affect the analysis results and the 
accuracy of the measurements decreases. Re-measuring the background (zero) 
spectrum eliminates the influence of the temperature. 

5.2.3 Ventilation Requirements 

Care should be taken in order to ensure a correct airflow around the DX4040 and avoid 
fan obstruction. Do not block fans air circulation. This would decreases life expectancy 
of most of the internal components. 

5.2.4 Operating Requirements 

DX4040 should operate only in two specific positions in order to obtain best 
performance and safety of the analyser: 
 

- In horizontal position, front panel facing the operator (for table use). 
- In vertical position (operator wearing the 

adjustable shoulder strap or the adjustable 
carrying harness). 

 

Do not operate the analyser standing on its 
sides (fans facing up and downwards). 
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When the analyser stands on a surface (in horizontal position), the rubber pads, located 
on the analyser, should prevent unintentional move of the analyser. 
 
If the analyser is used with the adjustable shoulder strap or the adjustable carrying 
harness during measurements, for optimum stability the user should preferably be in 
stand by position during measurements. 
 
Before starting a measurement campaign, ensure that the probe filter and the dust 
filters are clean. 

5.2.5 Protective Earthing Instructions 

Precautions should be taken so that the protective earthing scheme on the analyser is 
not defeated. 
 
Never connect AC/DC PSU to an AC mains socket that has no protective earth. 
Use only certified Power Supply Cord. 

5.2.6 Supply Connection 

5.2.6.1 AC/DC PSU Connection 

The AC/DC PSU must be connected to a power source with the AC voltage specified in 
this manual. Do not use with an extension cord or receptacle unless all three blades 
can be fully inserted to prevent blade exposure. 
 
Connect the power supply cord to Gasmet AC/DC PSU that is equipped with an 
appliance inlet. 
 
Use an uninterruptible power supply (UPS) if the electric power is subject to major 
disturbances or power failures. 
 
All cautions and warnings on the equipment must be noted. If the equipment is not in 
use for a long time, disconnect it from the mains to avoid damage from transient over-
voltage. 
 
Please make sure that before connecting the AC/DC PSU to the analyser or 
inserting the battery to the analyser that the manual power switch is in off 
position. 
 
For safety reasons, make the d.c. connection ( ) between the PSU and the 
analyser before connecting the PSU to the AC mains ( ). If the power cord 
is not in use (battery mode), disconnect the power inlet from the analyser and 
reinstall power inlet protective cover. 
 
The equipment must not be operated in wet conditions. 
 
The AC power supply cord should be routed so that it is unlikely that it will be 
damaged. If the AC power supply cord is damaged DO NOT OPERATE THE UNIT! 
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5.2.6.2 Battery Connection 

Follow the direction of the arrow located on top of the battery in order to insert the 
battery in the correct way into the DX4040 analyser. Ensure that the battery 
compartment lid is properly closed. 

5.2.7 Sound Level 

The highest sound pressure level of the analyser has been measured at a point 1 m 
from the enclosure of the equipment and with the sample pump switched on. 
 
Many authorities consider sound level created by the DX4040 as below hazard 
threshold. Special means, such as the use of protective earpieces, can decrease the 
sound level for the operator. 

5.2.8 Explosion Protection 

For your own safety, the equipment must not be used in hazardous areas (EX-
rated areas). The standard enclosure is not explosion proof. The equipment should not 
be used to measure explosive gas mixtures or gases that might form an explosive gas 
mixture with the ambient air.  
 
Gasmet Technologies Oy assumes no responsibility if DX4040 is used in 
hazardous areas. 
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6 EQUIPMENT OPERATION 
If the equipment is used in a manner not specified by the manufacturer, the 
protection provided by the equipment may be impaired. 
 
Before starting to operate the Gasmet FTIR gas analyser, read this Instruction & 
Operating Manual carefully and thoroughly. If you do not understand something or 
you are unsure what to do, please do not hesitate to contact your local distributor 
or Gasmet Technologies Oy. The contact information is at the bottom of every page. 
 
It is assumed that the user knows how to use a PDA running under Windows mobile. 
For further information, please refer to the PDA manual and Windows Mobile website. 
 
Please remember that measuring conditions should be non-condensing. 
 

6.1 Quick PDA Guide 

The user is strongly advised to read the PDA manual before operating the analyser. 
Below are some advises regarding powering of the PDA: 

• Turn on the device: Press the power button to turn on your device. The backlight 
of the keypad will light up and, after a few seconds. 

• Backlight Off: The backlight of the screen dims out after a period of inactivity 
(default 30 seconds while on battery power and 1 minute while on external 
power). To restore the backlight, tap the screen or press a button. 

• Entering the Suspend Mode: Your device automatically suspends after a period 
of inactivity (default 3 minutes while on battery power and 5 minutes while on 
external power). To manually suspend the device, briefly press the power button. 

• Turning Off: If you are not using your device, press and hold the power button for 
at least 3 seconds until the device plays a notification sound and turns off. 

 

6.2 Software Setup 

Software setup of the PDA is normally not required at start up, as the setup and pairing 
with the analyser has been realized in Gasmet Technologies Oy. However, user 
computer needs to be configured even if the user will only use the PDA for 
measurements. 
 
Under Windows 7 operating system and before installing software or drivers, the user 
must log in as Administrator and set User Account Control to low. Go to Control Panel 
→ User Accounts and select Change User Account Control settings (you will have to 
provide the Administrator password if you are logged in as an ordinary user). Select 
‘Never notify’ on the slider control (Figure 12): 
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Figure 12. User Account Control settings. 

 
This setting is required for all programs that are not certified for Windows 7. 
 

6.2.1 Software Pre-requirements 

Before starting to use the DX4040, setting up the computer is highly recommended. 
The following software/drivers/applications need to be installed before using DX4040:  
 

– Microsoft ActiveSync under Windows XP operating system (installation files located in 
Gasmet DVD). 

– Microsoft Windows Mobile Device Centre under Windows 7 operating system 
(installation files located in Gasmet DVD). 

– HASP key driver if Calcmet software will be installed. 
– USB to Serial converter driver (for live measurements with Calcmet software). 
– Calcmet software (for live measurements). 
– Calcmet library (for live measurements). 
– Calcmet software configuration (for live measurements). 

 

6.2.2 Synchronization PDA/Computer 

In order to synchronize the files recorded onto the PDA during field measurement, the 
computer uses software to access PDA memory via USB connection. If the operating 
system is Windows XP or Windows 7, this synchronization software needs to be 
installed using the information accessible in the provided Gasmet DVD (\\Calcmet Lite 
Software\Calcmet Lite - latest drivers). 
 
Before installing Microsoft ActiveSync or Windows Mobile Device Centre, ensure that 
the PDA is not attached to the computer using the provided USB cable. 
 

- Launch the installation file and follow the instructions. 
- Reboot the computer if required. 
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- Ensure that the computer antivirus software do not prevent the synchronization 

of files with the PDA. 
- Ensure that PDA battery is fully loaded. 
- Start the PDA. 
- Connect USB cable from computer to PDA. After few seconds, the 

synchronization software starts in the computer and the PDA memory is 
accessible via Microsoft Explorer. 

- If the connection to the PDA is impossible, check the following USB parameter 
onto the PDA: Start → Settings → Connections → USB to PC. If “Enable 
advanced network functionality” is checked, uncheck it. This can help to 
synchronize the PDA with the computer (Please go to: 
http://www.microsoft.com/windowsphone/en-us/howto/wp6/sync/troubleshooting-
windows-mobile-device-center.aspx for more details). 

 

6.2.3 HASP Key Driver Installation 

The HASP license keys used by Calcmet require a driver, which has to be installed 
before Calcmet software can be installed. The HASP drivers can be found on the 
Gasmet DVD (HaspUserSetup.exe), or you can download the most recent version from 
the manufacturer’s site:  
 
http://www.aladdin.com/support/hasp/enduser.aspx (Sentinel HASP/LDK Run-time 
Setup) 
 
Do not insert the HASP key yet. 
 

6.2.4 USB to Serial Converter Installation 

If the computer you are using does not have a physical COM port, you will need to use 
the USB to Serial port adapter supplied with the analyser. Gasmet USB to Serial 
converter is the only model recommended and tested by Gasmet Technologies Oy. 
This converter is certified to be recognized by Calcmet software. Please, follow the 
instructions below in order to install the converter successfully:  
 

- Ensure that the USB/Serial converter is not connected to the computer before 
installing the driver. 

- Insert the provided USB to Serial converter installation disk into your DVD drive. 
Browse the DVD and execute the setup file located in the following directory: 
~:\UC232A\Windows series\UC-232ADriverInstaller.exe 

- Follow the instructions below:  
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→ 

Click ’Continue Anyway’ Click ’Next >’ 

→ 

→ 

Click ’Finish’. Connect the 
USB/Serial converter. 

Select ’No, not this time’. Click ’Next’. 

Select ’Install the software automatically 
(Recommended)’. Click ’Next >’. 

Wait... 
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The COM Port number automatically allocated by the operating system will be needed 
during Calcmet use. 
 
Remember that connecting the converter to another USB port allocates another COM 
Port number. 
 
This number and other COM port parameters can be changed in Control panel → 
Device manager if necessary. 

6.2.5 Calcmet Software Installation 

Run Calcmet.msi from the software DVD delivered together with the Gasmet analyzer. 
After Calcmet has been installed, you can copy the Calcmet help file Calcmet.chm from 
the DVD to your computer, to the same folder where Calcmet was installed. If you have 

→ 

→ 

Click ’Continue Anayway’. Wait... 

Click ’Finish’. The converter is installed. Open the Device Manager. Ports item 
should show the new virtual COM port 
under the name ’USB-to-Serial Comm. 
Port’ 
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purchased the NIST/EPA vapor phase IR library for Calcmet, copy the file NIST.dll to 
the same location as well. 
 
Please, refer to the Calcmet software manual for further information. 

6.2.6 Calcmet Library Installation 

The library of reference spectrum files (.ref files) and the library configuration file (.lib 
file) are located on the Gasmet DVD, in a folder named CalcmetLibraryXXXXXX, where 
XXXXXX is the serial number of your Gasmet gas analyser. Copy this complete folder 
to the root of C: drive (C:\CalcmetLibraryXXXXXX). 
 
Please, refer to the Calcmet software manual. 

6.2.7 Calcmet Software Configuration 

When the Calcmet software starts, a welcome window “Welcome to Calcmet” appears 
(Figure 13). Enter the serial number of your analyser (a non-zero serial number 
prevents this screen from appearing when Calcmet is started), select your defined serial 
COM port, set the baud rate to 57600 bps, set the data format to 16 bits and the mode 
to standard. Click OK. Calcmet starts now in standard mode, as indicated by the status 
box in lower right hand corner of the Calcmet screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13. Calcmet Welcome window. 

 

6.2 Zero Calibration and Hardware Status Check 

Before making the zero check, ensure that the analyzer has been powered up for at 
least 30 minutes. At the end of this warm-up time, measure the hardware status by 
selecting View → Hardware Status. 
 

Select the correct 
COM port. 

 - If you have a Calcmet Professional HASP key, 
insert it now and check that the Calcmet Standard 
text changes to Calcmet Professional. 

- Go to Options → Application menu (or press 
CTRL+A). Click browse and select the application 
library file 
C:\CalcmetLibraryXXXXXX\SNXXXXXX.lib, where 
XXXXXX is the serial number of your analyser. 
This is the .lib file transferred from Gasmet DVD 
to your computer. 

- Connect DX4040 to computer using Gasmet serial 
cable. 

- Switch the analyser ON. 
- Wait for 15 seconds. 
- Go to: View → Hardware Status and check that 

the measurement was performed correctly. 
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The results should be within the limits below (Table 12):  
 
Cell temp  close to ambient temperature 

Cell pressure  close to ambient pressure 

Source intensity  > 50 % (original = 100 %) 

Interf. height  > 3 V when cell is filled with zero gas (original approx. 5.4 V) 

Interf. center  2000 ... 3000 points 

Electronics temp.  0 ... 50 °C 

Detector temp.  -37 °C 

Ext. detector temp.  +25 °C 

Table 12. Hardware status results. 

 
Connect zero gas supply to the sample gas in connector of the Gasmet gas analyzer, 
adjust flow to approximately 2 l/min and wait for 5 minutes. Set measuring time to 60 
seconds in Options → Measuring times menu and select Measure → Background. The 
background spectrum is used in following measurements of sample gas as the 
reference level of signal strength at various wavelengths. Measuring a new background 
spectrum constitutes the zero calibration of the gas analyzer and is the only calibration 
required for operation. The quality of the background spectrum can be viewed in View 
→ Calibration information menu ( 
Figure 14). The status should be “OK”, and percentage of original should be > 70 %. 
You are now ready to start sample measurements. 
 
 
 
 
 
 
 
 
Figure 14. Calcmet calibration information. 
 

6.3 Calcmet Application Creation 

Calcmet software is used to generate a new application for Calcmet Lite analysis 
software. Please read Calcmet manual in order to get further information on how to 
create an application. Some parameters from the application created in Calcmet can 
also be modified on Calcmet Lite software. These include:  
 

- Components included in the analysis 
- Component measuring ranges and alarm limits 
- Analysis areas and some analysis settings 
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- Interferences 

 
The following analyser components can be displayed on Calcmet Lite:  
 

- 219: Ambient Pressure 
- 222: Sample Cell Pressure 
- 231: Sample Cell Temperature 
- 232: Interferometer Temperature 
- 233: Detector Temperature 
- 234: IFG Peak Height 
- 235: Interferogram Center 

6.4 Calcmet Lite User’s Guide and Reference Manual 

6.4.1 Calcmet Lite Application Installation 

When the application is created in Calcmet, the next step is to copy the application 
(.LIB) and the reference spectra (.SPE) using ActiveSync USB to a folder on the PDA 
storage card. Before doing so, use a notepad-type text editor to change the paths of 
reference spectra in the application (.LIB) file to correspond to the folder on the storage 
card where the application is stored. If the path is correct, no error message is 
displayed when the transferred application is selected in Calcmet Lite from File → 
Select application. 
 
Please, refer to Microsoft ActiveSync® documents if you need further information about 
how to access PDA memory via ActiveSync. 

6.4.2 PDA Configuration 

Setting up the PDA (Personal Digital Assistant) is normally not required at the start-up, 
as it has been set up in Gasmet Technologies Oy.  
 
Calcmet Lite software is installed on the PDA. Calcmet Lite starts up the DX4040 via 
Bluetooth (if the Bluetooth connection is used), measures background, and stores it on 
the storage card of the PDA, measures spectrum files, and displays analysis results. 
 
Calcmet Lite requires an initialization file in order to keep the user settings in memory. 
This file is CALCMETLITE.INI. 

6.4.3 CALCMETLITE.INI File 

CALCMETLITE.INI is located in the PDA under the directory \Program 
Files\CalcmetLite\. This file includes the definition of the Device ID of the DX4040, its 
Bluetooth address, the COM Port that Calcmet Lite will use, the Baud Speed, the 
location of the different recorded files to be stored on the PDA, the minimal and 
maximal signal limits for the background, the timer defining the Bluetooth 
communications timeout. 
 
In order to modify CALCMETLITE.INI, copy the file from the PDA (\Program 
Files\CalcmetLite\ directory) to the desktop using ActiveSync. Open the file using a 
simple text editor like Notepad. 
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– Device ID:  
Each Gasmet DX4040 analyser contains a device ID. This ID depends of the serial 
number of the analyser. Gasmet sets the ID such way: GASMET+”Serial number of the 
analyser”. 
 

• Example: GASMET071170 
• Device ID will be displayed when you search for a Bluetooth module with 

the PDA. 
• Calcmet Lite displays device ID during start up if the correct DX4040 is 

found. 
 

– Bluetooth address: 
Each Gasmet DX4040 analyser contains its own device ID and its own Bluetooth 
address. The Bluetooth address is used by the Bluetooth search software to discover a 
Bluetooth device (Please, refer Appendix A in order to set up a Bluetooth connection 
with the analyser). 
 
When Calcmet Lite starts, the Bluetooth address of the analyser is checked and 
compared to the Analyser Bluetooth address stored in the CALCMETLITE.INI file. If the 
result of the comparison is positive then, the Device ID AND the Bluetooth address are 
displayed in Calcmet Lite and the measure menu is visible for starting measurements. If 
a connection cannot be established, error messages will be displayed regarding the 
connection failure. 
 

– COM port: 
This number corresponds to the Bluetooth COM port defined (By default, it is COM8). 
This value can also be 1 if the traditional RS232 COM port is used with the Gasmet 
serial cable. 
 

– Baud speed: 
Serial communication baud speed of the analyser: 57600 bps by default. 
 

– Path of the different recorded files: Backgrounds, spectrums and results. 
– Minimal and maximal signal limits for background: By default, MinSignalLimit = 

5000 and MaxSignalLimit = 30000. After a background is measured, Calcmet 
Lite checks it using MinSignalLimit and MaxSignalLimit. The information below 
explains how this check is made:  

 
 

All spectrum points are checked 
and the maximum value has to be 
above or equal to MaxSignalLimit. 
 
 

Spectrum points in between 900 
cm-1 and 4250 cm-1 are checked 
and minimum value has to be 
above or equal to MinSignalLimit. 
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• If the background taken by Calcmet Lite (and saved in the DX4040) fulfils the 
previous criteria’s, then Calcmet Lite saves the background. 

• If not, the background is saved and a window will be displayed after background 
measurement in order to notify the user that the background is low. 
 

- Timer: 
The Timer parameter defines the time (in ms) taken by the DX4040 to analyze a 
spectrum. Depending of the application size, the analysis can take hundreds of 
milliseconds to a couple of seconds before sending the results to Calcmet Lite. This 
parameter needs to be fine-tuned depending on the application loaded to the DX4040. 
If the Timer is set too low and the analysis takes more time than what is defined by the 
timer parameter, the results will not be displayed on the PDA. Instead, if the Timer is 
set too high, you might have some communication issues especially when the PDA is 
far (more than 5 meters) of the DX4040. 

6.4.4 Calcmet Lite Install/Uninstall 

Please, read Appendix B for further details on how to uninstall and reinstall Calcmet 
Lite software. 

6.4.5 Operating DX4040 via Bluetooth 

Before starting to use the DX4040 in standalone mode, ensure that the PDA and 
analyser batteries are fully charged. DX4040 batteries are fully loaded 
when the five LEDs displaying the status of charge of the battery are ON. 
This can be also checked on the front panel of the DX4040 when the 
analyser is ON. 
 
PDA battery power can be check by going to: Settings → System tab → 
Power. 
 

– Connect the battery (field-use) or the AC/DC PSU (laboratory-use). 
– Check the condition of sample probe filter (change the filter, if necessary). 

 
The following settings in the PDA should be activated:  

– COM Port settings in CALCMETLITE.INI should be 8 (factory settings). 
– PDA should be paired with the DX4040 (factory settings). 

 
The following settings in the DX4040 should be verified:  

– Manual Power switch should be set to Bluetooth mode. 
– Bluetooth LED should be blue. 
– Use the furnished stylus pen attached in the back of the PDA and click on the 

Calcmet Lite icon or go to: Start → Calcmet Lite (Figure 15). 
– If the Bluetooth connection is established, DX4040 is powered up. Bluetooth LED 

should be blue and battery status of charge LEDs on the front panel should 
display state of charge of the battery. 

– An info notification appears on the screen with the ID and the Bluetooth address 
of the analyser. 

– The measure menu appears in a couple of seconds. Calcmet Lite and the 
DX4040 are ready to measure. 
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Figure 15. Correct Calcmet Lite start-up sequence. 

 
– If the measure menu does not appear and there is an error message in Calcmet 

Lite (Calcmet Lite Demo Mode), it means that the Bluetooth connection is not 
established with the analyser or that the power sequence on the analyser failed. 
Please, ensure that the power supply is correct both on the PDA and on the 
analyser side and restart the start up procedure. In addition, you may need to 
shorten the physical distance in between the PDA and the analyser. 

6.4.6 Hardware Status 

The first step to accomplish after powering up the DX4040 is to measure some 
hardware parameters in order to validate the functioning of the analyser. A simple 
check in Calcmet Lite of the hardware status informs the user that the instrument is 
ready to operate. 
 
In order to confirm the hardware status, select Measure → Hardware Status. After 1 
second, the hardware parameters should appear (Figure 16). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16. Calcmet Lite Hardware Status. 

 
Hardware parameters to check are the following:  
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– Cell Temp: Temperature of the sample cell, which should be higher/close to the 

ambient temperature. 
– Ambient Pressure: Pressure of the atmosphere in millibars. 
– Cell Pressure: Pressure of the atmosphere in millibars. 
– Source Intensity: The percentage of source intensity indicates the state of the IR 

source inside the interferometer. This percentage is close to 100 % when the 
DX4040 leaves the factory.  

– Interf. Height: The interferogram height is the maximum value (in volts) of a 
measured interferogram. This value depends of the sample that is inside the 
sample cell. When the sample cell is flushed with nitrogen, interferogram height 
should be close to +5.4 V. During sample measurement, this value can decrease 
by a factor of 2. 

– Interf. Center: The interferogram center informs about the quality of the 
interferogram measured. This value can oscillate in between 2000 to 3000 points 
without analysis error. Center point value decreases when the enclosure 
temperature increases. 

– Electronics Temp.: Electronics temperature is measured on the main electronics 
board. This value can be 0 - 50 oC. 

– Detector Temp.: Detector temperature is the temperature measured on the 
Peltier element of the IR detector. This value is normally close to -37 oC. 

– Ext. Detector Temp.: External detector temperature is the temperature measured 
in the detector enclosure. This value is normally close to +25 oC. 

 
If the hardware status parameters are correct, the instrument is ready to perform a zero 
calibration. 

6.4.7 Zero Calibration 

DX4040 requires a zero calibration before starting to operate (Figure 17). Zero 
calibration requires the use of nitrogen or dry air. For better stability of the 
instrument, wait for the analyser to warm up during 10 minutes before zero 
calibration. 
 

– Be sure that the internal pump is not activated. That way, you will be able to test 
that the background is taken properly. Go to Settings → Measure Options tab. 
Uncheck: Activate Pump during continuous measurement. 

– Set up the measuring background time. This time is correlated to the sample 
measurement time defined in Measuring Time. A recommended measuring time 
is 5 or 20 seconds. These measuring times correspond to 20 second and 60-
second background times. Click ok on the top right end corner. 
The longer the measurement time is, the better the accuracy of the analysis 
results. Measuring time depends then on your application. 

– Flush the sample cell using a 6 mm Teflon tube attached to the ZERO GAS 
fitting. Zero gas should be nitrogen gas (quality 5.0 or higher) or clean/purified 
instrument air. In case neither is available, ambient air can be used. However, 
analysis performance will be impaired. Recommended flow should be about 
3L/min. 

– Wait for one minute to be sure that the sample cell is correctly purged. 
– Trigger a zero calibration by clicking to: Measure → Zero Calibration. 
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Figure 17. Calcmet Lite zero calibration. 

 
– An incorrect zero calibration is notified with a message printed in the screen: 

"Background Signal Low!" (Please, read section “install CALCMETLITE.INI file” 
in order to get further information concerning background check). 

– Trigger a continuous measurement by clicking START (check that the analysis 
mode is enabled). The point is to check that, after zero calibration, the analysis 
results are around 0 (if the sample cell is still purged with zero calibration gas). 

 
Pump needs to be deactivated when you check the zero calibration otherwise 
sample gas will enter the sample cell and zero results are invalid. 
 

– After a successful zero calibration, sample measurements can be performed. 
The sample pump is switched on when continuous measurement is started if 
pump mode is activated in Settings → Measuring→ Activated Pump during 
continuous measurement (Figure 18). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 18. Activate pump during continuous measurement. 
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6.4.8 Measurements 

At this point, please consider whether the measurements are stored in PDA memory or 
not. There are four alternatives:  
 
– Store the sample spectra (Figure 19). Sample spectra can then be downloaded onto 

the computer and be post analyzed using Calcmet software. Go to Settings → 
Autosaving → Autosave Spectra: All. Go to Settings → Save paths and click 
“Browse...” to specify the root folder for saving files, the various file sub folders and 
the name given to the saved spectrum files. Use the “built in” keyboard to enter the 
spectrum name. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19. Save spectrum files. 

 
– Store the background files. Background spectra can then be downloaded onto 

the computer and checked using Calcmet software. Go to Settings → Autosaving 
tab → Check Autosave Backgrounds. Use the “built in” keyboard to enter the 
background name and its sub folder for saving. 

 
– Store the measurement results as a text file (*.txt) or HTML files. Go to Settings 

→ Autosaving → Check Autosave Results as HTML or text file. Be sure that the 
analysis is switched ON. Go to Measure and check Analyze.  

 
– Store the sample spectra AND the measurement results. This can be done by 

selecting Measure → Analysis Enabled. Then, select Autosave Sample Spectra 
option and Autosave Results option and select one of the three following options 
in Settings → Autosaving:  

 
o Save spectra when high residuals (save the spectrum only when residual 

of at least one analyzed component is higher than the residual limit). 
o Save spectra when concentration alarm (save the spectrum only when 

concentration alarm is activated). 
o Save all spectra during analysis. 

 
Note that only a limited amount of spectra must be stored in the PDA memory. 
Download and erase spectrum files from the PDA when the amount is about a couple 
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of hundreds. The more you will store spectrum files, the longer it is going to take to 
access and to download them to your computer. The PDA is equipped in standard with 
an external CompactFlash® memory in order to save files. The user is recommended to 
store all recorded files onto external memory. 
 
When saving files onto internal or external memory, ensure that the files are saved into 
a subfolder created by the user. Do not save files directly under the root of the memory. 
 
Pay attention to always specify a file name with a limited number of characters for 
spectrums files and results files. Windows mobile operating system handles correctly 
files names with up to eight characters. As spectrums or results files are indexed with a 
counter number, pay attention that the file name and the index number are not more 
than eight characters. 
 
Sample measurement time can be set at Settings → Measuring. A recommended 
Measuring Time for most of the application is 5 or 20 seconds. Click ok on the top right 
end corner. 
 
The longer the measurement time, the better the accuracy of the analysis results. 
Measuring time depends then on your application. 
 
The actual measurement can be initiated by pushing the START button on the PDA 
display, which will begin a continuous measurement cycle (Figure 20). For example, 
when using a five (5) second measurement time, results (or sample spectra) will be 
updated every 5 seconds. It is also possible to initiate a continuous measurement by 
selecting Measure → Continuous. The last way to start continuous measurement is to 
push the upper left button on the PDA keypad (option only available with Gasmet 
provided PDA). A single measurement can be trigger by going at Measure → Single. 
 
Press the button STOP to cancel continuous measurement or push the upper right 
button on the PDA keypad (option available with Gasmet provided PDA). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20. START - STOP measurement. 

 
Measurement results (Figure 21) look like below depending of the measurement mode 
chosen: Spectrum results or analysis results (all components displayed or single 
component displayed). 

START 
continuous 

measurement 

STOP 
measurement 
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Figure 21. Measurement results (spectrum or analysis). 

 
– A progress bar located on top of the measurement screen informs the user of the 

measuring time. 
– In spectrum measurement mode, the spectrum is displayed by default in 

automatic scaling. 
– In analysis measurement mode, two displayed modes are possible: All 

components displayed or single component displayed. 
– If all the components are displayed, use the stylus pen and click on the 

component that you want to display in order to swap the display mode. 
– If a single component is displayed, use the stylus pen and click on the 

component name in order to swap the display mode. 
– Use the stylus pen to scroll up or down the view or, alternatively, press the Fn 

button first and then push up or down the arrow button on the PDA keypad 
(option available with Gasmet provided PDA) (Figure 22). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 22. Scrolling the results. 

 
– If all components are displayed, residual alarm is notified by the component 

name background displayed in red colour. 
– If a single component is displayed, residual alarm is notified by the residual 

information displayed in red colour. 

Scroll up or 
down using the 

stylus pen 
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– If all components are displayed, concentration alarm is notified by the result 

background of the component displayed in red colour. 
– If a single component is displayed, concentration alarm is notified by the bar 

graph displayed in red colour. 
– Range values can be modified only from File → Edit Application, selecting the 

component in the list and clicking Edit Selected. Click on the range value to be 
modified. Use the “built in” keyboard to update the new range value. Click Ok 
when done editing. 

– Alarm values can be modified only from File → Edit 
Application, selecting the component in the list and 
clicking Edit Selected. Click on the alarm value to be 
modified. Use the “built in” keyboard to update the new 
alarm value. Click Ok when done editing. 

– If Bluetooth communication is used in between analyser 
and PDA, some measurement errors can appear during 
measurement. This occurs more likely when the PDA is 
far from the analyser or the Timer parameter in the 
CALCMETLITE.INI file is not set properly. Approaching 
the PDA close to the analyser or increasing the Timer 
parameter solves this issue. 

– A good indication of how good the analysis is and how good the results are is the 
residual value. In successful measurements, the residual value must be below 
0.01 in the absorbance scale, and for precise measurements even better. If 
there are any clear spectral structures, or the base line is tilted, try to include 
some possibly missing components to the analysis and analyze the sample 
again to get better results. Sometimes it also may be necessary to measure the 
background again to get better results. 

 

6.4.9 Emailing Results and Spectra 

For emailing the results, the following settings on the PDA and Calcmet Lite have to be 
set: 
 

- WLAN must be turned on and properly logged on to an existing WLAN network. 
Please refer to the Windows Mobile documentation on how to configure WLAN 
communications on the PDA. Connection can be verified using the Internet 
explorer program found on the PDA. 

- The correct SMTP and email addresses have to be set from Settings → E-mail 
(Figure 23). 

- The latest results can be sent immediately from Settings → E-mail by pressing 
the button ‘Send last spectrum and results by e-mail’ or by setting the ‘Ask to 
send e-mail when residual alarm’ option. In the latter case, the user is prompted 
to send an e-mail when a residual alarm occurs after analysis. 
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Figure 23. E-mailing options. 

6.4.10 Checking Storage Space 
 
Remaining storage space for results and spectra can be verified from Help → Storage 
information. An alarm limit can also be set that notifies the user when the storage 
threshold has been exceeded (Figure 24). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 24. Storage information. 

6.4.11 Flushing and Switching Off DX4040 via Bluetooth 

– When the measurements are over and after every use of the DX4040, flush 
the sample cell properly with instrument nitrogen gas or instrument air. 
Clean ambient air can also be used. Sample cell is correctly purged when 
the analysis results go back around 0. 

– Check the filter. 
– When batteries are fully charged, brand new and pump is used during 

measurements, the DX4040 operates in average more than two and a half hours 
depending of the external temperature. 

– Batteries are fully discharged when the DX4040 stops to operate during 
measurement. A red LED on the front panel blinks when the state of charge of 
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the battery is below 10 %. Reconnect the AC/DC PSU in order to recharge 
battery. 

– DX4040 can be switch off on two different ways from Calcmet Lite via Bluetooth. 
o Go to File → Exit (Figure 25). Calcmet Lite software and analyser will 

switch off (if Bluetooth connection is still valid). 
o Click on the top right end corner cross. Calcmet Lite software and 

analyser will switch off (if Bluetooth connection is still valid). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 25. Switch off the analyser. 

 
6.4.12 Transferring of Spectrum/Results Files 

 
After synchronization of the PDA/computer, saved files can be accessed and 
transferred using Microsoft Explorer. It is strongly advised to synchronize only files. Do 
not start to synchronize calendar or contacts. Pay attention to limit the number of files 
saved onto PDA memory as the access time gets very long if many files are stored onto 
PDA memory. 

6.4.13 Application Selection 

Applications can be selected from File → Select Application (Figure 26). The user 
needs to specify the path where the application is located (normally under “Storage 
Card”) and the application file (*.LIB file). Click onto “Open file” in order to load the 
application. 
 
 
 
 
 
 
 
 
 
 
 

Figure 26. Application selection. 
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6.4.14 Update Calcmet Lite Settings 

Some Calcmet Lite parameters can be modified directly from the PDA. Those 
parameters are: 
 

- Language. 
- Analyser id. 
- Bluetooth address. 
- Serial port. 

 
Those parameters are located into CALCMETLITE.INI file. Required changes can be 
made from Start → Settings → Personal → Today → Items → CalcmetLite → Options 
(Figure 27). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 27. Calcmet Lite settings. 
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6.5 Measurements Summary 

 
– Ensure that the batteries are fully charged (during field use). 

 
 

– Ensure that the filter is cleaned. 
 
 

– Power up the analyser / Calcmet Lite software or Calcmet 
software. 

 
 

– Check and validate the hardare status parameters. 
 
 

– Wait for ten minutes before the analyser stabilize in temperature. 
 
 

– Flush the sample cell and perform a zero calibration. Pump is 
off. 

 
– Measurement consideration: Save or not save the results. 

 
 

– Measurement consideration: Pump is on. 
 
 

– Measurement consideration: Set Measuring Time. 
 
 

– Measurements in the field. 
 
 

– Flushing of the sample cell. Clean the filters. 
 
 

– Switch off DX4040. 
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7 EQUIPMENT MAINTENANCE AND SERVICE 

7.1 Safety Precautions 

Improper handling of any components inside the analyser may damage it. Thus, 
adjustment of any components inside the analyser voids the warranty. Any service 
operations that require opening the case of the analyser should be performed only by a 
trained service personnel. The case should only be opened when the analyser is turned 
off, battery pack, AC power cord and the gas lines are disconnected/removed. 
 
The user should pay attention to the following points: 
 
1 Every time after the measurements, the sample cell should be carefully flushed 

with nitrogen gas or dry instrument air. If corrosive gases remain in the sample 
cell, the optics inside the sample cell will be damaged. Measuring strongly acid or 
caustic gases will damage irreversibly the sample cell. 

 
2 If the sample gas contains solid particles, it should be filtered before introducing it 

into the sample cell. If it is not filtered, dirt will accumulate in the sample cell and 
lower the quality of the measurements. Any liquid droplets or aerosols inside the 
gas cell may destroy sample cell mirrors or optical windows. 

 
3 After power has been switched off for a longer period or the unit is used in extremely 

humid ambient conditions, it is recommended to purge the spectrometer and 
detector with dry nitrogen gas to avoid ice formation on the detector window. 

 
4 The pressure and temperature of the sample gas should always be kept as stable as 

possible. However, the gas entering the sample cell should already be as close as 
possible to the sample cell temperature. 

 
5 Intensive shocks may damage the analyser. Be always very careful when you 

move or transport the instrument. 
 
6 Use a soft cloth to wipe off the dirt on the case. The case of the analyser is not 

waterproof. Do not apply running water when cleaning the case. Do not use strong 
detergents or acetone. If the instrument is used in dusty conditions, it is 
recommended to vacuum clean the dust filters (and replace if necessary) at 
least once a month. The filters are located on the right and left side of the 
instrument. 

 
7 Never replace Gasmet Power supply cord by an inadequately rated cord. 

7.2 Parts Information 

All parts are available from Gasmet Technologies Oy and should only be obtained 
through Gasmet Technologies Oy. The parts listed in this manual refer to the following 
references: 
 

- Analyser: Gasmet DX4040 gas analyser. 
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- AC/DC PSU: External AC/DC Power Supply Unit from Gasmet reference ELE-

POW-006. 
- Battery pack: Gasmet rechargeable Li-ion battery reference 3ICP65/20/60-2 

(ELE-POW-004). 
- PDA: Gasmet Portable Device Assistant reference HAN-HELD-005. 
- USB to Serial converter: Gasmet recommended and tested USB to Serial 

converter reference EL278. 
- HASP key: Gasmet HASP Hardware Key with Gasmet firmware reference GAS-

SW-405. 
- Serial cable: Gasmet serial cable for DX4040 reference ELE-DSP-612. 
- Power cord: Gasmet Power supply cord. 
- Sample probe: Gasmet portable sample probe with filters, inserts and Tygon® 

tube reference SMP-PRB-017. 
- Sample probe filter: Gasmet sample probe standard filter reference EL140 
- Carrying harness: Gasmet carrying harness reference ME-961. 
- Shoulder strap: Gasmet shoulder strap reference ME-961. 
- Battery carrying case: Gasmet battery carrying case reference ME-961. 
- PDA carrying case: Gasmet PDA carrying case reference ME-961. 
- Strap: Gasmet plastic strap reference ME-961. 
- Dust filter: Gasmet air filter for DX4040 dust free use reference COW-FIL-003. 

7.3 Maintenance Plan 

Table 13 below presents an estimation of the maintenance plan. The maintenance 
required depends strongly on the application. The maintenance work procedures are 
described in this manual. 
 

Maintenance interval Maintenance work 

After every use Disconnect the equipment from AC outlet before cleaning the enclosure. 
Vacuum the dust filters. Check the probe filter and replace it if necessary. 
Read the instructions given below. 

1 month Visual inspection (according to the instructions given below). 

Approximately 12 months Annual service: analyser inspection, cleaning, tuning, and water calibration 
(performed by trained service personnel). 

2 – 3 years Infrared source replacement (performed by trained service personnel). 

3 – 5 years Laser source replacement (performed by trained service personnel). 

Table 13. Maintenance plan. 

In principle, the analyser requires no calibration except zero calibration after the original 
factory set-up. 

7.4 Enclosure Cleaning 

Use a damp rag to wipe off the dirt on the case. The case of the analyser is not 
waterproof. Do not apply running water when cleaning the case. Do not use strong 
detergents. 
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7.5 Replacing/Cleaning Dust Filters 

Dust filters are located behind the ventilators grids on the two side panels of the 
DX4040 analyser (Figure 28). It is highly recommended to vacuum clean the dust filters 
after every use. The filters can be replaced by opening the two 2.5 mm hexagonal 
screws holding the grid. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 28. Dust filters cleaning. 

7.6 Replacing Probe Filter 

Sample probe maintenance includes the replacement of the probe filter and the 
cleaning of the pressurized air blown through the probe. If the probe has been badly 
stained, water and suitable detergent can be used to clean it  
 
It is highly recommended to check the probe filter after every use and replace it if 
necessary (Figure 29). 

1. Pull the tube out of the probe by simultaneously pressing the connector on the 
probe and pulling the probe tube. 

2. Unscrew the two screws under the probe using a 2.5 mm hexagonal key. 
3. Lift the lid of the probe. 
4. Unscrew manually the black filter cover from the main body of the probe. 
5. Replace the filter. 
6. Screw manually the black filter cover back to its place. 
7. Insert the lid of the probe back and screw the screws back. 
8. Insert the probe tube back. 
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Figure 29. Probe filter cleaning. 

 

7.7 Visual Inspection 

When you make the visual inspection, check that: 
 
• Analyser cover is somewhat clean an unharmed. 
• Front panel, gas fittings, connectors are in good condition. 
• Sample gas flow is correct. 

7.8 Sample Cell Inspection 

The sample cell inspection can be made for all types of sample cells. Only a trained 
service personnel may perform sample cell inspection. The operation includes following 
procedures: 
 
• Sample cell optical window check. 
• Sample cell mirror inspection. 
• Water calibration. 
• Operational test. 

7.9 Replacement of Optoelectronic Components 

Only trained service personnel may perform replacement of any of the optoelectronic 
components. Expected lifetime of the detector is five (5) years and laser tube three (3) 
years. However, to avoid any unexpected faults, it is recommended that: 
 
• Infrared light source is replaced once in every 2 - 3 years. 
• Laser tube and its power source are replaced once in 3 - 5 years. 
• Detector is replaced if necessary. 
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8 ANALYSER INSPECTION 
The analyser must be inspected within 30 days from the date of delivery, to ensure that 
the warranty is valid in full. Please check the following points and fill the Gasmet FTIR 
Gas Analyser Inspection Sheet on the next page. If you noticed that something is 
missing or the analyser is damaged during transportation, please contact the nearest 
distributor or Gasmet Technologies Oy. Before you make this inspection, it is 
recommended to read Gasmet Instruction & Operating Manual, especially Chapter 
Equipment operation. 
 
1. Check the condition of the shipping box. 
 
2. Check that no items listed in Chapter List of Items Delivered for DX4040 are missing. 

 
3. Check visually that the analyser’s enclosure is undamaged. 
 
4. Switch the analyser power on. 

 
5. Wait before the analyser has reached the stable operating conditions. Then check 

the Hardware Status and write down all the parameters in the inspection sheet. 
 

6. After checking Hardware Status, measure a single sample spectrum with pure 
nitrogen and use 20 seconds measuring time. Save the sample spectrum. The 
sample spectrum includes a lot of information that can be used for troubleshooting 
purposes. It is important to use the factory-measured background in this test. Do not 
measure a new background! 

 
7. Send a copy of the filled Gasmet FTIR Gas Analyser Inspection Sheet to Gasmet 

Technologies Oy by fax, mail, or e-mail. Please see the contact information at the 
bottom of the page or on the last page of this manual. 
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 APPENDIX A: Bluetooth setup 

The following steps activate the Bluetooth connection:  
 

1. Switch on the PDA 
2. Switch on DX4040 in Bluetooth mode. 
3. Go to Start → Settings → Connections  
→ Bluetooth (Mode tab) 
4. Activate the 'Turn on Bluetooth' option and ‘Make this  

device visible to other devices’. 
5. Go to 'Devices' tab 
6. Click ‘Add new device...’ (Note: In order to remove a  

Bluetooth device from the list, click and hold with the  
stylus the device to be removed. A dropdown menu with 
the delete option will appear). 

7. Place the PDA near DX4040 
8. After approximately 10 seconds, the serial number of  
your DX4040 should be displayed on the list. 
9. Click on the serial number and then click 'Next' on  
the bottom right hand corner of the PDA display. 
10. Enter the pass code number using the built-in keyboard.  
The passkey number is 1234. Click 'Next'. The Bluetooth 
 connection is established when “Your Pocket PC has 
 connected with GASMET” is displayed. 
11. To set up a virtual COM port, select 'COM ports'  
tab in 'Bluetooth Settings'. 
12. Select 'New Outgoing Port' and add your DX4040 by  
clicking on the serial number. Click 'Next'. 
13. Select COM8 as the COM port number. Activate  
'Secure Connection' and click 'Finish'. 
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APPENDIX B: INSTALL/UNINSTALL CALCMET LITE 
The following procedure explains how to install or upgrade Calcmet Lite:  
 

- Backup the following files installed on 
the PDA (under: My Device\Program 
Files\CalcmetLite\) on your computer 
via USB connection: 
CALCMETLITE.INI, 
HardwareLimits.txt and 
CALCMET.BKG. 

- Go then to: Start → Settings → 
System → Remove Programs.  

- Click onto “Gasmet Technologies Oy 
CalcmetLite” and click “Remove”. 
“Remove Program”: Yes 

- Restart the PDA if requested. 
- Calcmet Lite Setup package is 

a “*.cab” file. This file is used 
to install Calcmet Lite onto the 
PDA memory. Transfer the 
setup file on the “My 
Documents” directory of the 
PDA. 

- Click onto the 
“CalcmetLite____.cab” file in 
order to start the installation. 

- During installation and if you 
have on your PDA an external 
Storage Card, the installation 
routine can prompt the location 
of the installation. Choose to 
install Calcmet Lite on the 
“Device”. 

- After installation, go to: Start → 
Settings → Today → Items 
(tab) and just click “ok” in the 
top right end corner. This will 
enable Calcmet Lite shortcut in 
the “Today” window. 

- Transfer back (copy) the 
following files onto the PDA (My Device\Program Files\CalcmetLite\): CALCMETLITE.INI, 
HardwareLimits.txt and CALCMET.BKG 

- Calcmet Lite installation/upgrade is over. 
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APPENDIX C: LI-ION BATTERIES GENERAL USAGE 
INSTRUCTIONS 
 
The following precautions should be observed when using Gasmet Li-ion batteries for 
DX4040. 
 
Storage: 

1. In order to avoid short circuits, handle batteries carefully. Always ensure that 
terminals are insulated. 

2. Prior to use, keep the battery at a temperature preferably not exceeding 30 °C. 
3. Initial state of charge of batteries before storage should be between 15 % and 50 

% of capacity and is defined by taking into account:  
1. The maximum consumption of electronic devices 
2. The self-discharge of the cells (the higher the state of charge, the higher 

the rate of the self-discharge) 
3. A minimum of 5 % of state of charge is required at the end of storage to 

avoid any ‘overcharge’. 
4. If after storage, the battery voltage is low or even 0 V, the battery protection 

circuit has probably gone into ‘sleep mode’. In such case, reset the battery with 
Gasmet charger. 

 
Use mode: 

1. Your battery has been designed for a specific application. Do not use it for any 
other application without agreement of Gasmet. 

2. Do not connect batteries in series or parallel. Irreversible damage can be done. 
3. Observe correct polarities during installation and charging. 
4. Use only a Gasmet charger designed for use with smart Li-ion batteries. 

Otherwise irreparable damage to the battery electronics could ensue. 
5. Do not heat above 70 °C. The batteries contain thermal fuses which could 

activate and make batteries inoperable. 
6. Your battery is designed with an electronic device to protect against 

overdischarge, overcharge and short-circuiting between the terminals. 
7. If you cannot discharge the battery, it may be overdischarged. Charge the 

battery for ½ hour and check again. 
8. If you cannot charge the battery, it may be overcharged. Discharge the battery 

and check again. 
9. If the battery has been short-circuited, charge it to reset the electronics with the 

Gasmet charger. 
10. If the battery has been short-circuited, status of charge can be wrong. Charge 

the battery for ½ hour and discharge the battery in order to reset smart battery 
values. 

11. If the battery still does not work, please contact Gasmet. 
12. Do not apply pressure that will deform the batteries. 

 
End of life: 

1. After numerous cycles, it is normal to observe a decrease in the battery capacity. 
2. Do not try to open or dismantle the battery since it would invalidate the warranty. 
3. Do not dispose of in fire. 
4. Recycle the battery by a specialist company. 
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APPENDIX D: RECOMMENDATIONS TO THE END-USERS OF 
BATTERIES 

 
The following represents a typical, but non-exhaustive, list of good advice to be 
provided by the manufacturer of secondary cells and batteries to equipment 
manufacturers and battery assemblers. 
 
a) Do not dismantle, open or shred cells. Batteries should be dismantled only by trained 
personnel. Multicell battery cases should be designed so that they can be opened only 
with the aid of a tool. 
b) Do not short-circuit a cell or battery. Do not store cells or batteries haphazardly in a 
box or drawer where they may short-circuit each other or be short-circuited by 
conductive materials. 
c) Do not remove a cell or battery from its original packaging until required for use. 
d) Do not expose cells or batteries to heat or fire. Avoid storage in direct sunlight. 
e) Do not subject cells or batteries to mechanical shock. 
f) In the event of a cell leaking, do not allow the liquid to come into contact with the skin 
or eyes. If contact has been made, wash the affected area with copious amounts of 
water and seek medical advice. 
g) Equipment should be designed to prohibit the incorrect insertion of cells or batteries 
and should have clear polarity marks. Always observe the polarity marks on the cell, 
battery and equipment and ensure correct use. 
h) Do not mix cells of different manufacturer, capacity, size or type within a battery. 
i) Seek medical advice immediately if a cell or battery has been swallowed. 
j) Consult the cell/battery manufacturer on the maximum number of cells, which may be 
assembled in a battery and on the safest way in which cells may be connected. 
k) A dedicated charger should be provided for each equipment. Complete charging 
instructions should be provided for all secondary cells and batteries offered for sale. 
l) Keep cells and batteries clean and dry. 
m) Wipe the cell or battery terminals with a clean dry cloth if they become dirty. 
n) Secondary cells and batteries need to be charged before use. Always refer to the cell 
or battery manufacturer’s instructions and use the correct charging procedure. 
o) Do not maintain secondary cells and batteries on charge when not in use. 
p) After extended periods of storage, it may be necessary to charge and discharge the 
cells or batteries several times to obtain maximum performance. 
q) Secondary cells and batteries give their best performance when they are operated at 
normal room temperature. 
r) Retain the original cell and battery literature for future reference. 
s) When disposing of secondary cells or batteries, keep cells or batteries of different 
electrochemical systems separate from each other. 
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APPENDIX E: LASER SAFETY INFORMATION 
 
DX4040 user should be aware that the apparatus contains a potentially harmful laser 
device. DX4040 fulfils the requirements for Laser Class 1 according to the standard EN 
60825-2007 (IEC 60825-2007). The laser device, included into the DX4040, is fully 
enclosed and only trained service personnel should open the enclosure in case of 
service of the analyser. Please, read carefully the following remarks:  
 

CLASS 1 LASER PRODUCT 
EN 60825-1:2007 

 
CAUTION – CLASS 3R LASER RADIATION WHEN OPEN 

AVOID DIRECT EYE EXPOSURE 
 

Caution – Use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation exposure. 

 
Label on the analyser:    Analyser label location: 
 
 
 
 
 
 
 
 
 
 
Label on the interferometer:  Interferometer label location: 
 
 
 
 
 
 
 
 
 
 
 
 
 

CLASS 1 LASER PRODUCT 
LUOKAN 1 LASERLAITE 

KLASS 1 LASER APPARAT 
EN 60825-1:2007 

CAUTION – CLASS 3R LASER 
RADIATION WHEN OPEN 

AVOID DIRECT EYE EXPOSURE 

VARO – AVATTAESSA OLET ALTTIINA 
LUOKAN 3R LASERSÄTEILYLLE 

ÄLÄ KATSO SUORAAN SÄTEESEEN 
VARNING – KLASS 3R LASERSTRÅLNING 

NÄR DENNA DEL ÄR ÖPPNAD 
BETRAKTA EJ STRÅLEN DIREKT 
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APPENDIX F: CERTIFICATION 
 
This device complies with Industry Canada licence-exempt RSS standard(s). Operation 
is subject to the following two conditions: (1) this device may not cause interference, 
and (2) this device must accept any interference, including interference that may cause 
undesired operation of the device. 
 
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux 
appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions 
suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de 
l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est 
susceptible d'en compromettre le fonctionnement. 
 
This Class A digital apparatus complies with Canadian ICES-003. 
 
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment. 
 
Note: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation 
of this equipment in a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his own expense. 
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APPENDIX G: VOCABULARY 
Absolute state of 
charge 

Relates to the capacity of a brand new battery and will therefore be reduced as the 
battery is ageing. 

Absorbance A measure of the amount of infrared radiation absorbed by a sample gas as a 
function of frequency. 

Beam splitter A component in the interferometer that reflects half of the infrared radiation and 
transmits the other half. 

Beer’s law The law stating that the absorbance is linearly proportional to the concentration of 
the gas (see page 17). 

Detector The component that measures the intensity of the infrared radiation and converts 
this value into electrical signal. 

Fourier transform 
(FT) 

The mathematical algorithm to get spectral data out of the interferogram. The 
algorithm transforms the intensity as a function of time values to intensity as a 
function of wavelength. 

Infrared (IR) Electromagnetic radiation that has wavelengths ranging from 0.75 µm to 1000 µm 
(14000 – 10 cm

-1
). 

Interferogram The measured intensity as a function of optical path length difference 

Interferometer The device that produces interference signal of the infrared radiation. 

Noise Detected signals that do not come from the sources that we actually want to 
measure.  

Reference 
spectrum 

A spectrum that is used as a known reference when determining the 
concentrations of unknown gas components. 

Relative state of 
charge 

Relates to the last full cycle and will therefore show 100 % when fully charged. 

Resolution The degree to which different frequencies can be distinguished from each other. 

Signal-to-noise 
ratio (SNR) 

The ratio of the amplitude of the actual measured signal to the amplitude of the 
noise at the same point. 

Spectrum A graph that shows the transmission of the infrared radiation through the gas as a 
function of wavelength 

Transmittance The ratio of the infrared radiation transmitted through the sample gas to the 
amount of the infrared radiation entering the sample gas.  

Wavelength Another form of expressing the frequency of the infrared radiation: the distance 
between two peaks in the oscillation.  

Wave number Number of wavelengths in a centimeter. For example, if the wavelength is 10 µm, 
the corresponding wave number is 1000 cm-1. 
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APPENDIX H: GASMET SALES AND SUPPORT OFFICES 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manufacturer  
Gasmet Technologies Oy 

Pulttitie 8 
00880 Helsinki 

FINLAND 
 

Tel. (+358) 9 7590 0400 
Fax (+358) 9 7590 0435 

contact@gasmet.fi 
 
 

Subsidiary in North America 
Gasmet Technologies Inc. 

956A The Queensway 
Toronto, Ontario, M8Z 1P5 

CANADA 
 

Tel: +1 866-685-0050 
sales@gasmet.com 

 
 
 
 

 
 

Subsidiary in Asia  
Gasmet Technologies (Asia) Ltd. 

Unit 1, 7/F, 
Fook Hong Industrial Building, 

No. 19 Sheung Yuet Road, 
Kowloon Bay 

Kowloon 
HONG KONG 

 
Tel: +852 3568-7585 
Fax: +852 3568-4600 

sales@gasmet.com.hk

Distributors 
 Please see our website at http://www.gasmet.fi 
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